Agriscience Project Curriculum

Promoting Student Research in Secondary Agricultural Education

Created June 2013
• Lesson 1: Scientific Method
• Lesson 2: Background Research
• Lesson 3: Data Analysis
• Lesson 4: Discussion of Results
• Lesson 5: Conclusion
• Lesson 6: Creating a Poster
• Lesson 1: Scientific Method

Lesson
✓ Lesson Plan
✓ Scientific Method PowerPoint
✓ Note Organizer: Scientific Method
✓ How to Train Your Dragon Video Worksheet
✓ How to Train Your Dragon Video Worksheet Key
✓ Teacher Guide: Writing Procedures
✓ Writing Procedures Activity Example
✓ Reinforcement Activity: Identifying Type of Variables
✓ Reinforcement Activity: Writing Hypothesis

Agriscience Project
✓ Agriscience Project PowerPoint
✓ Agriscience Interest Survey- Animal Science
✓ Agriscience Interest Survey- Plant Science
✓ Notebook Outline Packet
✓ Notebook Grade Sheet
✓ Research Expense List
**Desired Outcomes for this Lesson**

**Goal for this lesson:**
The goal of this lesson is to provide students with a basic understanding of the scientific method allowing them to develop their individual research skills in future lessons.

**Standards addressed in this lesson:**
AGCL.01.03.b- Discuss the relationship between the advancement of technology and the need for continuing education and career development.

**Objectives:** *By the end of the lesson the learner will...*
- List the seven steps of the scientific method in order.
- Explain the importance of science and research in Ag.

**Essential Questions:**
Why are science and research important to agriculture? Why is the scientific method necessary for research?

### Assessments to Measure Student Growth

**Unit:**
Completion of Agriscience Project

**This lesson:**
Video Worksheet

### The Learning Plan

| Materials:                  | PowerPoint: Scientific Method  
|                            | Sticky Notes  
|                            | Note Organizer: Scientific Method  
|                            | Candy/Prizes  
|                            | Video: How to Train Your Dragon  
|                            | Video Worksheet: How to Train Your Dragon (and Key)  
|                            | Teacher Guide and Materials for Writing Procedures Activity and Materials  
|                            | Reinforcement Independent Worksheets  
| Terms to Know:              | Quantitative Research, Qualitative Research, Independent Variable, Dependent Variable, Constants, Control Group, Hypothesis  
| Special Instructions:      | This lesson can be taught earlier than the other lessons so that students can have time to think about their projects. Topic selection should occur well before the projects are started.  
| Engage-Motivation:         | Ask students to respond to this question on a sticky note or scrap paper: What is one practice or product that we use in agriculture today that resulted from research or science? The answer may be specific or general. Ask students to share with the class. Follow up with the questions: Do you believe research important in agriculture and what does it do for society?  
| Time: 10 min.              |  
| Explain-Provide new info:  | Present Scientific Method power point to prepare students with an understanding of the steps of the scientific method and the vocabulary related to research. Explain to students the importance of recognizing the steps essential to research so they can apply them in to their Agriscience Projects.  
| Time: 35 min.              |  
| Explore-Discovery of info: | Supply students with the How to Train Your Dragon Worksheet. Be sure to have watched the necessary portions (~51 minutes) and read through the worksheet and answer key. Remind students they will be looking for each step of the scientific method in video and they should raise their hand or tell you to stop the video each time they see a step or find an answer to the worksheet. You can give students candy or a prize if they correctly identify and justify the answer to a question. Give students a few seconds to explain and record their answer.  
| Time: 75 min.              | Parts of the Video to Show:  
|                            | Part 1: The Experiment  
|                            | 0-47:05 (Chapter 1-9) - can save 3 minutes by skipping Chapter 2  
|                            | Part 2: Discovery and Benefit to the Society  
|                            | 56:00-59:00  
|
Evaluate: Ask students why they think you showed this particular video, did it apply to the material cover in class? Ask students to decide if similar situations and methods are used in real life. Give students the opportunity to discuss as a class. Once students have shared their ideas, show the short clips of Yu the Loggerhead Sea Turtle and Winter the Bottlenose Dolphin. The video links are listed on the key to How to Train Your Dragon Worksheet. Wrap up the day with a review of the steps of the scientific method.

Time: 20 min.

Elaborate-Apply in a new context: Be sure to set up scenario A and B before class. Take a picture of each so that students can see what the set up was and compare it to their results. Be sure that students will not be able to see the scenario they will be required to set up. Explain to the students that they will have ten minutes to write a procedure that will allow their partner to set up the scenario. Assign partners and have them begin. After the students have written their procedure have them exchange procedures with their partners. Give students 10 minutes to follow the procedure to replicate the scenario. Show students what each scenario looked like and compare it to what they set up. (See Example Procedure for Scenario A and B as a guide for writing procedures)

Time: 45 min.

Evaluate: Ask students why they believe a carefully written procedure is important. What would have helped them write their procedures? What would have been useful for their partner to include in their procedure? Ask students what the consequence would be if a scientist did not write clear procedures for their experiment.

Time: 10 min.

Reinforcement Activity: Provide students with the “Writing Hypothesis and Identifying Variables” and “Identifying Dependent and Independent Variables” for additional practice or to complete if they finish working on another project or assignment early.

Time: Varies

**Agriscience Project Tasks**

**Materials:** Area of Interest Survey (Animal and/or Plant)  
Composition Notebooks for Each Student  
Task Checklists-Cut into Individual Check Sheets for Each Student  
Notebook Format Packet (Several Classroom Copies)

**Topic Selection:** Ask students to fill out the Area of Interest Survey. Walk around the room and take several minutes to discuss each student’s idea. It may be necessary to spend some time outside of class brainstorming on potential topics for each student. Be sure to remind students that once the topic is selected it cannot be changed since supplies will need to be gathered.

**Notebook Work:** Students should copy the headers from the Notebook Format Packet into their notebook. Each page of the packet shows the spread of the notebook. This task is best completed as a class so students do not get confused. A computer or doc cam can be used to display the Notebook Format Packet or several copies can be passed out for students to share.

Students may begin to complete the Task Checklist once they have selected their topic. At this point students will be able to fill in their Observation, Ask a Question, Primary Research Question and Sketch.
United States Department of Agriculture Research, Education and Economics (REE) Action Plan that “as the 21st century unfolds, America faces economic, social, and environmental challenges that require strong and innovative systems of food and agricultural science for answers and technology solutions” (United States Department of Agriculture [USDA], 2012).

One of the REE’s goals presented in their action plan is to “recruit, cultivate, and develop the next generation of scientists, leaders, and a highly-skilled workforce for food, agriculture, natural resources, forestry, and environmental systems, and life sciences to out-educate our global competitors” (USDA, 2012).


“DuPont Agriculture offerings brings innovative science and solutions to meet the challenges faced by farmers today and into the future. In agriculture, succeeding for our customers means growing a healthy, marketable and profitable crop. For DuPont, it means something bigger: feeding the world sustainably. Our mission is to deliver agricultural products from seeds to crop protection to deliver higher crop yields and more nutrition foods. We believe that by working together with our customers, we can find better ways to improve quantity, quality and sustainability of the world’s food supply.
Steps of the Scientific Method

1. Make an Observation
2. Ask a Question
3. Background Research
4. Form a Hypothesis
5. Test the Hypothesis/Conduct Experiment
6. Analyze Results
7. Draw Conclusions

Types of Research

Quantitative
- Data includes measurements or counts
  - Standard scales

Qualitative
- Descriptions

Quantitative Examples: temperature, Fahrenheit
Qualitative Examples: color, emotions, descriptions of the environment
What is a variable? 
Definition: Variable - "things or factors that can be assigned or take on different values in an experiment"
Definition: “a prediction of the relationship of an independent and dependent variable to be tested in an experiment; it predicts the effect that changes purposely made in the independent variable will have on the dependent variable” (Students and Research)

- Hypothesis can be non-directional
  - __________________________ will differ under __________________________ conditions.
  - or
  - __________________________ and __________________________ will have different __________________________ conditions.

- If-Then Hypothesis- predicts an outcome
  - Non-Directional- difference or no difference
  - If-Then hypothesis (more common)
    - “If independent variable is related to dependent variable, then predict the effect.”
    - or
    - “If the independent variable is describe the changes, then the dependent variable will predict the effect.”

- Non-directional Hypothesis
  - __________________________ will differ under __________________________ conditions
  - or
  - __________________________ and __________________________ will have different __________________________ conditions.

Examples from Students and Research:
- Directional Research Hypothesis-
  - “Wood production in trees adjacent to herbicide-treated fields will be less than wood production in trees adjacent to non-herbicide treated fields”
- Non-Directional Research-
  - “Wood production in trees adjacent to herbicide treated fields will differ from wood production in trees adjacent to non-herbicide treated fields”

Image: http://pascencio.cos.ucf.edu/methods%20presentation.html
Hypothesis Example

Directional
- If cattle are fed corn, then the rate of gain will be greater than cattle fed grass.
- Rate of gain in cattle fed corn will differ from cattle fed grass.

Non-Directional
- The growth rate of a plant will differ under green light. Then the growth rate will increase when exposed to green light.

Hypothesis Example
Ask students “What a procedure is?” before giving definition.
Definition: The specific steps used to complete an experiment including the required materials.
Procedures Activity
Why are they important?
The Scientific Method and Methods for Research Notes

What are 3 words or phrases describing the importance of research in agriculture?

List the Steps of the Scientific Method in Order:

1.
2.
3.
4.
5.
6.
7.

What are the two types of hypotheses?

1.
2.

List two ways to increase the validity of your experiment.

1.
2.

Vocabulary Matching:

- Quantitative Research
- Qualitative Research
- Independent Variable
- Dependent Variable
- Constants
- Control Group
- Hypothesis
- Procedures

- Factors that are not changed during the experiment
- Unchanged by the researcher to measure unpredicted changes
- Responds during the experiment
- Use background research to form
- Altered or manipulated for the experiment
- Specific steps used to complete an experiment and materials
- Descriptive Data
- Data Including Measurements and Counts
How to Train Your Dragon Video Worksheet

1. What observation did Hiccup make that prompted his research?

2. What was Hiccup’s research question?

3. List the sources Hiccup used for his background research and what did he find in each source?

4. What was Hiccup’s hypothesis?

5. What skills did Hiccup have that allowed him to conduct his experiment?

6. Describe the procedure Hiccup used to test his hypothesis.

7. Fill in the Data Table

<table>
<thead>
<tr>
<th>Trial Number</th>
<th>Description</th>
<th>Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8. What might Hiccup’s discussion look like in a paper?

9. What conclusion did Hiccup draw in his experiment?

10. What motivated Hiccup to conduct his research?

11. What additional, unforeseen benefit did society and the village of Berk receive from Hiccup’s experiment involving an animal?

12. List two real life examples discussed in class that involved animals being helped using prosthetic limps.
How to Train Your Dragon Video Worksheet

1. What observation did Hiccup make that prompted his research?

Toothless did not leave the valley.

2. What was Hiccup’s research question?

Why won’t Toothless fly away?

3. List the sources Hiccup used for his background research and what did he find in each source?

Textbook- there is little known about Night Furries

Goobler the Teacher

How do you sneak up on Night Furry?- no one knows

Can’t fly-can’t fight- dead dragon

4. What was Hiccup’s hypothesis?

Toothless cannot fly because Night Furries have a bilaterally symmetric tail. Toothless will be able to fly if his tail is repaired using a prosthetic tail fin.

5. What skills did Hiccup have that allowed him to conduct his experiment?

Blacksmith Assistantship prepared him to build the prosthetic tail.

6. Describe the procedure Hiccup used to test his hypothesis.

1. Build a prosthetic tail made of leather, identical to the remaining fin on Toothless
2. Strap the tail fin to Toothless.
3. Run test- See if Toothless can fly.
4. Record data.

7. Fill in the Data Table

<table>
<thead>
<tr>
<th>Trial Number</th>
<th>Description</th>
<th>Outcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8. What might Hiccup’s discussion look like in a paper?

Trial 1, a static or fixed tail was unsuccessful. Toothless was only able to remain airborne for several seconds with this tail. Trial 2 dynamic, collapsible tail allowed Toothless to remain airborne.

9. What conclusion did Hiccup draw in his experiment?

The hypothesis was correct. Dragons cannot fly without a bilaterally symmetric tail. A prosthetic tail fin can be used to allow dragons to fly if the tail fin is flexible and retractable.

10. What motivated Hiccup to conduct his research?

Compassion or concern for Toothless.

11. What additional, unforeseen benefit did society and the village of Berk receive from Hiccup’s experiment involving an animal?

Hiccup learned that the dragons were typically friendly and only being aggressive due to the control of the giant dragon. This allows the village to help the dragons by stopping the giant dragon. This resulted in the dragons no longer stealing sheep from the village of Berk.

12. List two real life examples discussed in class that involved animals being helped using prosthetic limps.

1. Yu- The Loggerhead Sea Turtle

(National Geographic Q&A: How a Turtle with Fake Limbs Got a Leg Up Article and Video) [http://newswatch.nationalgeographic.com/2013/02/20/turtle-prosthetics-give-helping-lim/](http://newswatch.nationalgeographic.com/2013/02/20/turtle-prosthetics-give-helping-lim/)

2. Winter- The Bottlenose Dolphin

[http://www.seewinter.com/winter](http://www.seewinter.com/winter)
Writing Procedures

Purpose:
Teach students the importance of writing clear and precise procedures for experiments and research projects.

Materials:
- Toothpicks
- Paper Towels
- Other Small Parts: Washers, etc.
- Rulers (optional)
- Protractors (optional)

Set Up:
Before class, using toothpicks and other small parts set up stations for each student in the class, half should be Scenario A and half should be Scenario B. Cover the scenarios with a paper towel so that students cannot see the set up when they enter the classroom. Take a picture of each scenario or use the attached examples.

Activity:
Explain to students the importance of writing accurate procedures. Ask students what should be included in a good procedure and what might improve their procedures.

Students may want to include:
- Materials List
- Clear, Concise Instructions
- Measurements (if they suggest it)

Each student will need to write a procedure for their partner to recreate the set up in the scenario. Assign partners. One partner will go to Scenario A and one partner will go to Scenario B. Give students 10 minutes to write their procedures. Tell students to take the procedures written by their partner and go to their partner’s station and recreate the scenario.

Wrap Up:
Show students the pictures or diagrams of each scenario. Ask students to share their experiences and answer discussion questions.

Discussion Questions:
- What did your partner include in their procedure that was helpful?
- What would have been useful to have in the procedure?
- What would happen if researchers don’t include accurate procedures?
Scenario A

Materials:
1- 9" by 12" Piece of Green Construction Paper  
1- 12" Black Pipe Cleaner  
1- 6" Medium Green Pipe Cleaner  
1- 6 ¼" Blue Foam Popsicle Stick

Procedure
1. Obtain 1 sheet of 9" by 12" Green Construction Paper.
2. Place the paper in front of you in the landscape position (the long edge running parallel to you).
3. Take 1- 12" Black Pipe Cleaner and place it running horizontal to the long edge of the construction paper 1" from the bottom (the side closest to you) of the paper.
4. Obtain 1- 6 ¼" Blue Foam Popsicle Stick and find the center of the long side of the popsicle stick (3 ⅛") and align it with the center of the of the top of the paper (6 ¼"). The popsicle stick should be placed running horizontal to the long side of the top (the side furthest from you) centered on the long edge. The edge of the popsicle stick should be aligned with the edge of the paper so the popsicle stick is entirely on the paper.
5. Take 1- 6" Medium Green Pipe Cleaner and bend it into a circle with the ends just touching. Place the circle with the top of the circle centered at 4" down from the top (side furthest away from you) and 6" from the side (find the center of the long side).

Scenario B

Materials:
1- 9" by 12" Piece of Blue Construction Paper  
1- 6" Dark Blue Pipe Cleaner  
1- 6" Light Blue Pipe Cleaner  
1- 6 ¼" Purple Foam Popsicle Stick

Procedure
1. Obtain 1 sheet of 9" by 12" Blue Construction Paper.
2. Place the paper in front of you in the landscape position (the long edge running parallel to you).
3. Take 1- 6" Dark Blue Pipe Cleaner and bend the pipe cleaner at a 90° angle with 3" on each side. Repeat this step with 1- 6" Light Blue Pipe Cleaner.
4. With the construction paper still in the landscape position place the Dark Blue Pipe Cleaner in the top (side furthest from you) left corner so that the pipe cleaner follows the corner of the paper. Repeat this step in the bottom (side closest to you) right corner with the Light Blue Pipe Cleaner.
5. Obtain 1- 6 ¼" Purple Foam Popsicle Stick. Place the popsicle stick in the center of the paper perpendicular to the long edge of the paper. In order to complete this step find the center of the short side of the popsicle stick (¾") and align this to the center of the construction paper (~6"). While keep the popsicle stick centered lengthwise, find the center of the long side of the popsicle stick (3 ⅛") and align it to the center of the short side of the paper (~4 ½").
Identifying Dependent and Independent Variables
Animal Science

Circle the Independent Variable and Underline the Dependent Variable.

A diet high in concentrate will increase the rate of gain in cattle.
Increasing frequency of handling will decrease stress in animals.
The calving period will be decreased when synchronization is used in cattle.
The microbial count in food processing facilities will differ based on the sanitation technique used.
The total amount of growth will increase depending on grazing frequency.
Different breeds of dairy cattle will produce different levels of butterfat in their milk.

Identifying Dependent and Independent Variables
Plant Science

Circle the Independent Variable and Underline the Dependent Variable.

Longer periods of exposure to sunlight will increase plant growth.
The rate of germination will vary depending on the type of seed.
The presence of a root growth hormone will increase root growth in spider plants.
Different levels of nutrients in the soil will affect plant growth.
Seeds stored at different temperatures will have different levels of viability.
Spoilage of fruit will increase at higher temperatures.
Writing Hypothesis and Identifying Variables
Animal Science

Write an “If Then” hypothesis for each of the following experiments and identify the independent and dependent variables.

Experiment #1: Pigs will produce higher quality meat if they are handled in groups.

Independent Variable:

Dependent Variable:

Hypothesis:

Experiment #2: Rations and Cattle

Independent Variable:

Dependent Variable:

Hypothesis:

Experiment #3: Free Range vs. Conventional Chickens

Independent Variable:

Dependent Variable:

Hypothesis:
Writing Hypothesis and Identifying Variables
Plant Science

Write an “If Then” hypothesis for each experiment and identify the independent and dependent variables.

Experiment #1: Nitrogen and Plant Growth

Independent Variable:

Dependent Variable:

Hypothesis:

Experiment #2: Color and Plant Growth

Independent Variable:

Dependent Variable:

Hypothesis:

Experiment #3: Root Growth Hormone and Snake Plants

Independent Variable:

Dependent Variable:

Hypothesis:
Project Categories

- Animal Systems
- Environmental Services/Natural Resource Systems
- Food Products and Processing Systems
- Power, Structural and Technical Systems

Agriscience Projects

Understanding the categories and rules
Animal Systems

Study of Animal:
- Life Processes
- Health
- Nutrition
- Genetics
- Management
- Processing

Examples:
- compare nutrient levels on animal growth
- research new disease control mechanisms
- effects of estrous synchronization on ovulation
- compare effects of thawing temperatures on livestock semen
- effects of growth hormone on meat/milk production

Environmental Services/Natural Resource Systems

Study of:
- Waste Management
- Management of Natural Resources and Influence on Environment

Natural Resources: Soil, Water, Wildlife, Forest, and Air
Examples:
- effect of agricultural chemicals on water quality
- effects of cropping practices on wildlife populations
- compare water movements through different soil types
Examples:
- effects of packaging techniques on food spoilage rates
- resistance of organic fruits to common diseases
- determining chemical energy stored in foods
- control of molds on bakery products

Plants: Crops, Turf Grass, Trees, Shrubs and Ornamental Plants
Power, Structural and Technical Systems

Study of:
- Agricultural Equipment
- Power Systems
- Alternative Fuel Sources
- Precision Technology

Social Science Applications: Agriculture, Food and Natural Resources

Examples:
- Investigate perceptions of community members towards alternative agricultural practices
- Determine the impact of local/state/national safety programs upon accident rates in agricultural/natural resource occupations
- Comparison of profitability of various agricultural/natural resource practices
- Investigate the impact of significant historical figures on a local community
- Determine the economical effects of local/state/national legislation impacting agricultural/natural resources
Plagiarism- don't do it, use quotations
Ethics Statement- do not commit scientific fraud or misconduct
- presentation of others works as your own
- fabrication of data
- falsification of data

Safety
- no live vertebrates at the fair
- no chemicals, hypodermic needles, syringes or crystals at the fair
- no human, warm blooded animal, or wild cultures (skin, throat, mouth, etc.)
- no exhibits using over 120 volts
- overall exhibits must be safe!
Logbook

- Date
- Description of Activities/General Observations
- Data Table/Chart with Observation for Each Treatment

Written Report

- Title Page
- Abstract
- Introduction
- Review of Literature
- Materials and Methods
- Results
- Discussion and Conclusion
- References
- Acknowledgements

Title Page- Short Descriptive Title (<15 words), name, grade, school and school address
Abstract- brief summary of purpose, methods, results and conclusion (no discussion, citations or references to tables/figures)
Introduction- “Why was the work done?” state problem, purpose of research, findings of earlier work, general approach and objectives
Review of Literature- review previous studies, similar research methods, history of research on topic- how will your research improve upon existing information
Materials and Methods- enables others to reproduce results by duplicating experiment- past tense, third person
Results- summarize results- just the facts observations, trends and relationships
Discussion and Conclusion- recap results/discuss if they were different from expected, did they support your hypothesis- why did you see what you saw, draw conclusions, tie to literature
References- only cite reference that were used, use APA Format, give credit if not common knowledge
Acknowledgements- anyone who helped you
## Interest Survey

**Name:** __________________________  **Class:** __________________________  **Date:** __________

### Area of Interest:

- [ ] Cats
- [ ] Dogs
- [ ] Poultry
- [ ] Rabbits
- [ ] Equine
- [ ] Beef Cattle
- [ ] Dairy Cattle
- [ ] Sheep
- [ ] Swine
- [ ] Goats
- [ ] Fish
- [ ] Bees

### Area of Investigation:

- [ ] Nutrition
- [ ] Behavior
- [ ] Reproduction
- [ ] Health
- [ ] Space/Facilities
- [ ] Weight Gain
- [ ] Handling Techniques
- [ ] Breeding (Genetics)
- [ ] Food Production

### What resources do you have available to you through family or friends? (Animals/Facilities/Experts)

<table>
<thead>
<tr>
<th>Resource</th>
<th>Owner of Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Do you have an idea of what you would like to do for your Agriscience Fair Project?

- ________________________________________________
- ________________________________________________
- ________________________________________________
- ________________________________________________
- ________________________________________________
- ________________________________________________
- ________________________________________________
- ________________________________________________
- ________________________________________________

### What experiences or skills do you have in the areas you have selected?

- ________________________________________________
- ________________________________________________
- ________________________________________________

### What are your hobbies?

- ________________________________________________
- ________________________________________________
Area of Interest:

- Vegetables
- Fruits
- Ornamentals
- Trees
- Shrubs
- Grasses
- Other Crops
- Turf Grasses

Area of Investigation:

- Growth Medium
- Growth Rates
- Seed Viability
- Light
- Propagation
- Watering Rates
- Temperature
- Nutrients
- Seed Germination
- Fertilizing Rates
- Food Production
- Hormones
- Production Methods
- Soil Type
- Soil Conditions
- Root Growth
- Competition
- Irrigation Methods
- Storage
- Pruning

What resources do you have available to you through family or friends? (Plants/Facilities/Experts)

<table>
<thead>
<tr>
<th>Resource</th>
<th>Owner of Resource</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Do you have an idea of what you would like to do for your Agriscience Fair Project?

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

What experiences or skills do you have in the areas you have selected?

________________________________________________________________________

________________________________________________________________________

What are your hobbies?

________________________________________________________________________

________________________________________________________________________
Agriscience Notebook Outline

Notebooks

1. Blank Table of Contents Page
2. Observation
3. List Research Questions
4. Primary Research Question and Picture
5. Identify Variables
6. Background Research Questions (Glue in)
7. Non-Directional Hypothesis
8. Background Research
9. Reference List
10. If Then Hypothesis
11. Materials Required
12. Procedures
13. Notes on Experiment Set Up
14. Data and Observations
15. Daily Journal /Log
16. Discussion of Results
17. Conclusion

Daily Journal Questions/Topics

1. What professional would research your agriscience project?
2. What impact would your research have on the industry (plant or animal)?
<table>
<thead>
<tr>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
</table>

Table of Contents:
Entity:

Independent Variable:

Dependent Variable

Background Research Questions:
<table>
<thead>
<tr>
<th><strong>Background Research: Entity [Title]</strong></th>
<th><strong>Leave Blank or Use to Write Additional Background Research Notes for Entity</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Write the entity background research question here!</td>
<td></td>
</tr>
</tbody>
</table>

Write Notes and Citation Here- Do not copy- Write all notes in your own words.
<table>
<thead>
<tr>
<th>Background Research: Independent Variable [Title]</th>
<th>Leave Blank or Use to Write Additional Background Research Notes for Independent Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Write the independent variable background research question here!</td>
<td></td>
</tr>
<tr>
<td>Write Notes and Citation Here- Do not copy- Write all notes in your own words.</td>
<td></td>
</tr>
</tbody>
</table>
**Background Research: Dependent Variable [Title]**

Write the dependent variable background research question here!

Write Notes and Citation Here- Do not copy- Write all notes in your own words.

**Leave Blank or Use to Write Additional Background Research Notes for Dependent Variable**
<table>
<thead>
<tr>
<th><strong>Background Research: Relationship</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>[Title]</strong></td>
</tr>
<tr>
<td>Write the relationship background</td>
</tr>
<tr>
<td>research question here!</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Write Notes and Citation Here- Do not</td>
</tr>
<tr>
<td>copy- Write all notes in your own</td>
</tr>
<tr>
<td>words.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Leave Blank or Use to Write</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional Background Research</strong></td>
</tr>
<tr>
<td><strong>Notes for Relationship</strong></td>
</tr>
</tbody>
</table>
Reference List:
<p>| If Then Hypothesis: | Materials: |</p>
<table>
<thead>
<tr>
<th>Notes on Experiment Setup:</th>
<th>Additional Notes on Experimental Setup</th>
</tr>
</thead>
</table>


### Agriscience Notebook Outline

**List of Areas of Observation:**

**Sketch of Data Table (to be created in Word):**
<table>
<thead>
<tr>
<th>Daily Journal [Date]:</th>
<th>Daily Journal [Date]:</th>
</tr>
</thead>
</table>


Daily Journal [Date]:

Daily Journal [Date]:

Daily Journal [Date]:

Daily Journal [Date]:

Agriscience Notebook Outline
| Discussion of Results: | Additional Space for Discussion of Results: |
Conclusion:

Additional Space for Conclusion:
<table>
<thead>
<tr>
<th>Daily Questions:</th>
<th>Daily Questions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>What professional/specialist would research your agriscience fair project? Describe their career.</td>
<td>What impact would your research have on the industry (plant or animal)?</td>
</tr>
<tr>
<td>Name: Notebook Grade Sheet</td>
<td>Name: Notebook Grade Sheet</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><strong>Section/Page</strong></td>
<td><strong>Section/Page</strong></td>
</tr>
<tr>
<td>Observation/Ask a Question (5pts)</td>
<td>Observation/Ask a Question (5pts)</td>
</tr>
<tr>
<td>Primary Research Question/Sketch (5pts)</td>
<td>Primary Research Question/Sketch (5pts)</td>
</tr>
<tr>
<td>Non Directional Hypothesis (5pts)</td>
<td>Non Directional Hypothesis (5pts)</td>
</tr>
<tr>
<td>Entity/Variables (5pts)</td>
<td>Entity/Variables (5pts)</td>
</tr>
<tr>
<td>Background Research Questions (5pts)</td>
<td>Background Research Questions (5pts)</td>
</tr>
<tr>
<td>Date</td>
<td>Expense Item</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Lesson 2: Background Research

Lesson
✓ Lesson Plan
✓ Background Research PowerPoint
✓ Class Research Project Worksheet-Food Study
✓ Scientific Article
✓ Scientific Article Cutouts
✓ Scientific Article Key

Agriscience Project
✓ Agriscience Notebook PowerPoint
✓ Background Research Questions Worksheet
✓ Introduction Organization Handout (Harland, 2011)
## Desired Outcomes for this Lesson

**Goal for this lesson:**
The goal of this lesson is to build stronger research skills which students will apply in order to complete background research for their Agriscience Projects.

**Standards addressed in this lesson:**
ESSK.02.03.c- Reference the sources of information.
ESSK.03.04- Conduct technical research to gather information necessary for decision-making.
ESSK.04.04.b- Search for information and resources.
ESSK.04.04.c- Evaluate Internet resources for reliability and validity.

**Objectives:** *By the end of the lesson the learner will...*
- Identify the components of a scientific journal article (variables, hypothesis, procedures, results, areas for additional research).
- Explain the importance of background research for an experiment.
- Create appropriate background research questions for a research project.

**Essential Questions:**
- Why is background research important?
- How do you form background questions?
- How do you read a scientific journal article and what should you look for?

## Assessments to Measure Student Growth

**Unit:**
Completion of Agriscience Projects

**This lesson:**
Completion of Background Research for Class Project
Completion of Background Research in Agriscience Notebooks

## The Learning Plan

**Materials:**
- Class Research Project Background Research Worksheet- Food Study
- Scientific Article- *Sensory evaluation of organic and conventional fruits and vegetables available to Irish consumers*
- Scientific Article Cutouts and Envelopes
- Glue
- Tape
- PowerPoint- Background Research Part 1
- PowerPoint- Background Research Part 2

**Terms to Know:**
The OWL at Purdue. (2013). Research and citation resource. Retrieved from Purdue Online Writing Lab website: http://owl.english.purdue.edu/owl/

**Special Instructions:**
During this step students will begin their Agriscience Notebooks and the Class Experiment. It is recommended that you cut the Scientific Article Cutouts into pieces and place them into envelopes to give to the students to reduce the amount of time needed for this activity.

**Engage-Motivation:**
Ask students “What is the purpose of background research?, Why is it important?” Allow class to discuss the answers to these questions. Pose each of the following questions to students:
- No Entity Research-What would happen if you chose to do an experiment involving mice but did not take the time to research the general care requirements for this species?
- No Independent Variable Research- What would happen if you decided to perform an experiment involving water temperature and tadpoles and did not research the maximum temperature at which a...
Agriscience Project Tasks

| Materials: | Computer  
Library or Library Database  
Composition Notebooks  
Background Research Question Worksheet  
Introduction Organization Handout (Harland, 2011) |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Explain</td>
<td>Using the PowerPoint- Background Research Part 2, explain to students how they will conduct their own research and find resources. Review the format of their journal pages and how to make a reference list using APA style. Remind students that sites like Wikipedia should not be used as a reference. Instruct students to complete their background research for their projects. Remind students that they will need to create a reference list in a word document as they go and will need to provide in text citations for all of the information they gather in their notebooks in case they need to check the fact later. Once their research has been gathered they can then write their introduction.</td>
</tr>
<tr>
<td>Notebook Work:</td>
<td>Students need to write one question for each of the background research areas on the Background Research Question Worksheet. This worksheet should be glued into the student’s notebook. Be sure to approve the background research questions before students move on. Students should complete their background research for their project on the four research questions they developed (Computer Required). Be sure to monitor the students’ progress and provide assistance as needed. Time needed for this portion will vary depending on students’ ability and whether or not research is assigned as homework. Review student work before they move on. Once background research is complete students are able to write their introduction using the Introduction Components Handout (Computer Required).</td>
</tr>
</tbody>
</table>
What is the purpose of Background Research?
Steps Prior to Background Research

- Make an Observation/Pick a Topic
- Ask a Question
- Write Background Research Questions

Write Background Research Questions

- Four Areas
  - Entity - the area being studied
  - Independent Variable
  - Dependent Variable
  - Relationship between Entity and Variables

Background Research Questions
- Entity (the general area/thing being studied)
- Types that can be studied
- Handling/care/safety/ethics within a controlled environment
- Independent Variable
- Structure and Function
- How can it safely and ethically be manipulated
- Dependent Variable
- Structure and function
- Best method to measure, record, and observe
- Relationship
- Previous research on the topic
Class Research Project

- **Area:** Food Production

- **Observation:** Many people claim there is a noticeable difference between organic and conventional food products.

- **Question:** Can people tell the difference between organic and conventional food products?

Background Research Questions

- **Entity**

- **Independent Variable**

- **Dependent Variable**

- **Relationship between Entity and Variables**

**Entity:** What are the different types of food production exist?

**Independent Variables:** What is makes a product organic/what is organic production? What is makes a product conventional/what is conventional production?

**Dependent Variables:** What senses can be used to assess food products?

**Relationship between Entity and Variables:** When looking at consumer preferences of food production products, which senses can be used to distinguish between organic and conventional food products?
**Background Research Reference**

**Creating a Citation:**

**Author:** Rachel Tobin, Siobhan Moane, and Tracey Larkin

**Article Title:** Sensory evaluation of organic and conventional fruits and vegetables available to Irish consumers

**Pages:** 157-162

**Name of Journal:** International Journal of Food Science and Technology

**Year Published:** 2013

---

**Citation**

- **Organic**
  - A labeling term that indicates approved methods were used to produce the product without synthetic fertilizers, irradiation or genetically modified product.


- **Conventional**
  - Primary method of food production using highly efficient practices and "technology, large scale production, hybrids, chemicals (pesticides/herbicides), fertilizers."

  Source:
  "Sustainable Agriculture: Terms and Definitions" compiled by Mary V. Gold (2007)
Null Hypothesis

- The null hypothesis is the hypothesis that the researcher is testing. The null typically states that there is no difference between two characteristics.

Source:

Significant Difference

- Statistical significance is determined through statistical calculations and indicates the likelihood the outcome was related to the results or due to chance.

Source:
Step 1: Read the Introduction and Materials and Methods sections and glue the appropriate term at each arrow. Stop when you get to the Results section.

Do not glue without checking your results!

Step 2: After the class discussion on the Results, Table 160, analyze the results using the instructions at the top of page 159 and read the Results, Discussion, and Conclusion sections and glue the appropriate term at each arrow.

Step 3: Return to page 159 and read the Results, Discussion, and Conclusion sections and glue the appropriate term at each arrow.
Area: Food Production

Observation: Many people claim there is a noticeable difference between organic and conventional food products.

Question: Can people tell the difference between organic and conventional food products?

Background Research Questions

Entity

Independent Variable

Dependent Variable

Relationship between Entity and Variables

Background Research Reference:

Hypothesis:
Original article

Sensory evaluation of organic and conventional fruits and vegetables available to Irish consumers

Rachel Tobin,* Siobhan Moane & Tracey Larkin

Department of Applied Science, Shannon Applied Biotechnology Centre, Limerick Institute of Technology, Mungliss Park, Limerick, Ireland

(Received 31 January 2012; Accepted in revised form 17 July 2012)

Summary Many Irish consumers believe organic foods taste better; however, scientific data to support this are scarce, inconclusive and limited in scope. Quantitative descriptive analysis was used to compare the sensory properties of nine organic and conventional fruits and vegetables. A panel of nine was trained according to ISO international standards (8586-1, 1993). Independent t-tests of individual descriptor data and a two-way repeated measures ANOVA of the entire data set were carried out via SPSS 19. Statistical analysis of panel scores failed to show any significant differences between the organic and conventional samples for any of the descriptors assessed (P < 0.05 and less) or between the overall organic and conventional data sets (P < 0.05). In conclusion, the study found no statistically significant differences between the sensory attributes of a range of organic and conventional fruits and vegetables available to the Irish consumer.

Keywords Fruits, Ireland, organic food, sensory evaluation, vegetables.

Introduction

Foods are generally perceived by appearance, odour/fragrance, consistency/textures and finally flavour; however, in reality, these perceptions often occur in parallel as an overall sensory experience. Sensory evaluation attempts to isolate the sensory properties of foods and other products and can be defined as a scientific method that is used to evoke, measure and interpret responses to the sensory properties through the senses (Lawless & Heymann, 2010). Sensory evaluation assesses these properties using trained panellists or consumer groups for the purpose of rating the quality of a product, or comparing one product to another (Meilgaard et al., 2007). In the last 20–30 years, there has been a significant development in the use of sensory evaluations in the food and beverage industry. These developments have grown from a better recognition of human perception and developments in statistical tools. Sensory evaluation can be an invaluable tool in product development and product improvement, such as the assessment of the effects of formulation changes to the sensory properties. Evaluations can also be used for comparisons to competitor products and also shelf-life establishment (Kemp et al., 2009).

Descriptive analysis is the detection and description of sensory properties of a product; these properties combine to define the sensory profile of the product. Products may have the same sensory profile but may differ in the intensity of the properties; these intensities can be numerically scored, which allows for a number of products to be statistically compared (Meilgaard et al., 2007).

Organic foods can be generally defined as foods that are produced under strict regulations using an agricultural management system that promotes and enhances biodiversity, biological cycles and soil health with a minimum use of off-farm inputs, Organic Trade Association (2011). A 2008 survey by An Bord Bia showed that 27% of Irish consumers believe organic foods taste better, but could these consumers distinguish organic and conventional foods in a blind study? Is it possible that the perception of organic food as a more natural and safer product influences the sensory experience? (Tobin et al., 2011). Scientific studies on the question are limited and cover few food types. A review conducted in 2004 by Trewhallas stated that research findings are inconsistent and added that freshness is an important factor often confused with organic because of local sourcing. Table 1 lists some of the most recent sensory comparisons of organic and conventional foods and their findings.

Another survey of Irish consumers by An Bord Bia showed that 21% of organic rejecters state that they do not buy organic foods because they do not know what the benefits are. This would clearly suggest that...
more scientific research must be carried out to inform consumers of the differences, if any, associated with organically produced foods. In a similar survey carried out by An Bord Bia, organic consumers were asked where they bought their organic products. The results showed that a large majority visit large supermarket chains and buy their organic products along with their general purchases (An Bord Bia, 2008). Many previous sensory studies on the comparison of organic and conventional foods included samples collected directly from farms only. It was also noted that, to a consumer, variations such as soil type, fertilisation and geographical factors are unknown and perhaps unimportant. Therefore, the aim of this research was to provide a consumer-relevant study of organic fruits and vegetables and their conventional counter parts to show whether Irish consumers purchasing organic fruits and vegetables receive a higher sensory quality product or whether no difference exists. The foods included in the study were also chosen based on An Bord Bia survey data on the most popular and frequently purchased organic products (An Bord Bia, 2008).

Materials and methods

Nine fruits and vegetables were tested during the study, namely carrots (raw and cooked), onions, broccoli, vine tomatoes, cherry tomatoes, apples, potatoes, bananas and oranges. Of the fifty-four sample batches purchased for the study, 96% were sourced from large supermarkets (e.g. Tesco, Lidl) and 4% were sampled from a local organic producer to account for a minority of consumers visiting local organic markets.

Table 1 Recent studies on the sensory comparison of organic and conventional foods and their findings

<table>
<thead>
<tr>
<th>References</th>
<th>Foods tested</th>
<th>Findings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Haglund et al. (1999)</td>
<td>Carrots</td>
<td>Conventional carrots higher in carrot taste, sweetness and crunchiness. Organic carrots higher in hardness and pronounced after-taste ($P &lt; 0.01$ or less). In a triangle test, panelists could distinguish between organic and conventional samples only when the skin was left on.</td>
</tr>
<tr>
<td>Wasilewski et al. (2005)</td>
<td>Red skin potatoes</td>
<td>Descriptive analysis of carrots for appearance, aroma, texture and taste found no significant difference ($P &lt; 0.05$). Analysis of mushrooms for the same descriptors also showed no significant difference; however, it was indicated that organic mushrooms had darker gills and a stronger aroma ($P &lt; 0.05$).</td>
</tr>
<tr>
<td>Gilsenan et al. (2008)</td>
<td>Carrots and Mushrooms</td>
<td>No significant difference in appearance, aroma and taste was observed. However, baked conventional samples were perceived to be significantly softer, less adhesive and wetter than organic baked samples ($P &lt; 0.05$).</td>
</tr>
<tr>
<td>Gilsenan et al. (2010)</td>
<td>Potatoes</td>
<td>In a 4-year study, differences were seen within single crop years; however, pooled results showed that year-to-year, variety and geographical variations were equal or more important factors.</td>
</tr>
</tbody>
</table>

Sample preparation

Six sample batches of each food (three organic and three conventional) were purchased simultaneously the day before analysis to avoid differences because of degrees of freshness. Preparation was carried out on the morning of analysis in an adjoining preparation kitchen and depended on the nature of the samples (Table 2 shows the preparation carried out for each food type). All samples were washed before preparation. Cooked samples were steamed simultaneously in a segregated household electric steamer to avoid variations because of cooking times and temperatures.

Panel training and selection

The sensory panel was recruited in January 2011. The criteria for panelists were the following: they were available to volunteer for the project, nonsmokers, in good health and regular consumers of the samples included in the study. Participants who were willing to volunteer then completed a consent form and diet survey. Training in sensory analysis principles and qualitative descriptive analysis commenced with ten

Table 2 Sample preparation

<table>
<thead>
<tr>
<th>Food</th>
<th>Preparations</th>
<th>Cooking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carrots (raw)</td>
<td>Ends removed, peeled, chopped into batons</td>
<td>N/A</td>
</tr>
<tr>
<td>Carrots (cooked)</td>
<td>Ends removed, peeled, chopped into batons</td>
<td>Steamed for 15 min</td>
</tr>
<tr>
<td>Onions</td>
<td>Skin removed, sliced</td>
<td>Steamed for 10 min</td>
</tr>
<tr>
<td>Broccoli</td>
<td>Uniform florets prepared</td>
<td>Steamed for 15 min</td>
</tr>
<tr>
<td>Vine tomato</td>
<td>Vine removed, chopped in to segments</td>
<td>N/A</td>
</tr>
<tr>
<td>Cherry tomato</td>
<td>Vine removed, chopped in half</td>
<td>N/A</td>
</tr>
<tr>
<td>Apple</td>
<td>Stalk removed, chopped into segments</td>
<td>N/A</td>
</tr>
<tr>
<td>Potato</td>
<td>Peeled, chopped into cubes</td>
<td>Steamed for 15 min</td>
</tr>
<tr>
<td>Banana</td>
<td>Peeled and broken in half</td>
<td>N/A</td>
</tr>
<tr>
<td>Orange</td>
<td>Chopped into segments</td>
<td>N/A</td>
</tr>
</tbody>
</table>
participants according to ISO international standards (8586-1, 1993). Panellists were trained over 3 months (2 h per week) on their ability to differentiate between basic taste solutions at various levels, aromas and colours. The next stage of training was to describe and discuss descriptors in fruits and vegetables in terms of appearance, aroma, texture and taste. The panel was evaluated for correct detection of basic taste solutions and consistent scoring of descriptors of fruit and vegetable reference samples. Of the ten participants, nine (two men and seven women) panellists performed sufficiently in these evaluations and proceeded to analysis.

Sensory analysis

For each evaluation, the panel would decide on a range of appropriate descriptors that should be used to assess and compare the test samples. This was done using a reference sample for each fruit/vegetable. This session acted as a panel calibration as panellists established benchmark scores for each descriptor. The panellists' sensitivity was also tested before each evaluation using basic taste solutions. Sweet, sour, bitter, salty and savoury solutions at various levels had to be correctly identified before the panellist could sit for evaluation. This ensured all panellists were detecting changes in tastes sufficiently before scoring test samples.

For the analysis, six randomly coded prepared samples (three organic and three conventional) were placed on coded white paper plates, in no particular order, and presented to each panellist in separate white booths. The panellists used mineral water as a palate cleanser between tastings. The test room was also equipped with special white lighting and kept free from any strong smells. The panellists were instructed to assess each test sample in order of aroma intensity, visual appearance, intensity of colour, textures upon bite/chew and individual tastes observed. Each sample was scored between 1 and 9 for each of the descriptors, 1 denoting a low intensity for the descriptor and 9 denoting high intensity.

Data analysis

All panel scores were transferred to an Excel worksheet, and the means and standard deviations were calculated. The data were transferred to SPSS Statistics 19 software (SPSS Inc., Chicago, IL, USA). Independent t-tests were carried out for each fruit/vegetable for each descriptor to determine whether the samples scored significantly different for any individual attribute. The use of multiple t-tests can inflate the probability of type I experiment-wise error (false positives) however, and hence, a Bonferroni correction was applied to ensure significant differences were true differences and not because of error. The correction lowered the significance level of the test by the formula 0.5/N where N is the total number of tests employed.

A two-way repeated measures analysis of variance (ANOVA) was carried out on the entire data set that consisted of ten fruit/vegetable groups (treating cooked and raw carrots as separate groups) with six samples of each (three organic and three conventional), sixty-seven individual descriptors with 201 vs. 201 mean panel scores for organic and conventional samples in total.

The null hypothesis for the statistical analysis was there is no significant difference between the sensory properties of the organic and conventional fruits and vegetables assessed (P < 0.05).

Results

The results of the quantitative descriptive analysis of the organic and conventional fruits and vegetables tested are shown in Table 3.

Discussion

The raw carrots were scored based on the following descriptors: intensity of orange colour, carrot aroma, hardness on bite, moistness on chew, crunchiness on chew, sweetness and bitterness (after-taste). Organic samples scored higher for moistness, sweetness and bitterness. Conventional samples scored higher in all other descriptors; however, differences recorded were not statistically significant (P < 0.05). Gilsenan et al. (2008) also found no significant difference (P < 0.05) between organic and conventional carrots. However, the study by Haglund et al. (1999) found conventional carrots scored significantly higher in sweetness and crunchiness and organic carrots scored higher in hardness and after-taste (P < 0.01), none of which were observed in this study.

Cooked carrots were scored based on the following descriptors: intensity of orange colour, carrot aroma, firmness on bite, moistness on chew, sweetness and bitterness (after-taste). Both sample sets scored equally for aroma and conventional samples scored higher in sweetness, albeit not statistically higher. The organic samples scored higher for colour, moistness, bitterness and firmness. Organic samples were calculated to be significantly higher in moistness at the P < 0.05 significance level; however, when the Bonferroni correction was employed, the significance level was reduced to P = 0.0083, which deemed the P value as no longer significant, and the null hypothesis was then accepted.

Onions were compared based on the following descriptors: intensity of white/yellow colour, onion aroma, crunchiness on chew, sweetness and onion after-taste. Organic samples scored equal for sweetness and lower than conventional samples for all other
Put a line through any descriptors in Table 3 with a P-value greater than 0.05.
Circle the higher mean value for any remaining descriptors.
Circle the name of the fruit or vegetable with a significant difference.

<table>
<thead>
<tr>
<th>Descriptor</th>
<th>Mean Organic</th>
<th>Mean Conventional</th>
<th>P value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carrots raw</td>
<td>6.0 ± 0.16</td>
<td>6.0 ± 0.14</td>
<td>0.779</td>
</tr>
<tr>
<td>Carrot aroma</td>
<td>6.1 ± 0.12</td>
<td>6.1 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Hardness (on bite)</td>
<td>5.0 ± 0.12</td>
<td>5.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Moisture (on chew)</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Sweetness</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Bitterness (after)</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Carrots cooked</td>
<td>6.0 ± 0.16</td>
<td>6.0 ± 0.14</td>
<td>0.779</td>
</tr>
<tr>
<td>Carrot aroma</td>
<td>6.1 ± 0.12</td>
<td>6.1 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Firmness (on bite)</td>
<td>5.0 ± 0.12</td>
<td>5.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Moisture (on chew)</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Sweetness</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Bitterness (after)</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Onions</td>
<td>6.0 ± 0.16</td>
<td>6.0 ± 0.14</td>
<td>0.779</td>
</tr>
<tr>
<td>Onion aroma</td>
<td>6.1 ± 0.12</td>
<td>6.1 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Firmness (on bite)</td>
<td>5.0 ± 0.12</td>
<td>5.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Moisture (on chew)</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Sweetness</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Bitterness (after)</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>6.0 ± 0.16</td>
<td>6.0 ± 0.14</td>
<td>0.779</td>
</tr>
<tr>
<td>Broccoli</td>
<td>6.1 ± 0.12</td>
<td>6.1 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>5.0 ± 0.12</td>
<td>5.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>4.0 ± 0.12</td>
<td>4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>3.0 ± 0.12</td>
<td>3.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>2.0 ± 0.12</td>
<td>2.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>1.0 ± 0.12</td>
<td>1.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>0.0 ± 0.12</td>
<td>0.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-1.0 ± 0.12</td>
<td>-1.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-2.0 ± 0.12</td>
<td>-2.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-3.0 ± 0.12</td>
<td>-3.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-4.0 ± 0.12</td>
<td>-4.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-5.0 ± 0.12</td>
<td>-5.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-6.0 ± 0.12</td>
<td>-6.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-7.0 ± 0.12</td>
<td>-7.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-8.0 ± 0.12</td>
<td>-8.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-9.0 ± 0.12</td>
<td>-9.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-10.0 ± 0.12</td>
<td>-10.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-11.0 ± 0.12</td>
<td>-11.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-12.0 ± 0.12</td>
<td>-12.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-13.0 ± 0.12</td>
<td>-13.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-14.0 ± 0.12</td>
<td>-14.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-15.0 ± 0.12</td>
<td>-15.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-16.0 ± 0.12</td>
<td>-16.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-17.0 ± 0.12</td>
<td>-17.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-18.0 ± 0.12</td>
<td>-18.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-19.0 ± 0.12</td>
<td>-19.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-20.0 ± 0.12</td>
<td>-20.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-21.0 ± 0.12</td>
<td>-21.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-22.0 ± 0.12</td>
<td>-22.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-23.0 ± 0.12</td>
<td>-23.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-24.0 ± 0.12</td>
<td>-24.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-25.0 ± 0.12</td>
<td>-25.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-26.0 ± 0.12</td>
<td>-26.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-27.0 ± 0.12</td>
<td>-27.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-28.0 ± 0.12</td>
<td>-28.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-29.0 ± 0.12</td>
<td>-29.0 ± 0.12</td>
<td>0.981</td>
</tr>
<tr>
<td>Broccoli</td>
<td>-30.0 ± 0.12</td>
<td>-30.0 ± 0.12</td>
<td>0.981</td>
</tr>
</tbody>
</table>
Apples were scored based on their intensity of skin colour, apple aroma, hardness on bite, juiciness on chew, leathery skin, sourness, sweetness and apple flavour. Organic samples scored higher in aroma, juiciness and sourness. Conventional samples were higher in all other attributes of which sweetness was calculated to have statistical significance at the $P < 0.05$ significance level. After the Bonferroni correction, the adjusted significance level of 0.0063 excluded the $P$ value for apple sweetness and the null hypothesis was no longer rejected.

Potatoes were analysed for the following descriptors: intensity of white/yellow colour, potato aroma, soapiness (waxiness), flouriness (dryness/softness), potato taste, sweetness and astringency (drying after-taste). Organic samples scored higher for colour, soapiness and astringency. Conventional samples scored higher for all other descriptors of which flouriness was calculated to be statistically higher ($P < 0.05$). The Bonferroni correction lowered the level of significance to 0.0071, and hence, the null hypothesis was no longer rejected. Similarly to studies by Wszelaki et al. (2005) and Gilsenan et al. (2010), the panel did not distinguish between the organic and conventional potato samples. Hajsllová et al. (2005) did observe differences but noted other factors as more or equally important to growing method.

The panel assessed the banana samples for intensity of pale yellow colour, banana aroma, firmess on bite, astringency/clowness, sweetness and banana flavour. Organic samples scored slightly higher for colour, aroma, firmness and astringency/clowness; however, none of the differences recorded had statistical significance ($P < 0.05$).

Oranges were scored based on intensity of orange colour, orange aroma, juiciness on chew, fibrosity on chew, sourness/acidity, sweetness and orange flavour. Organic samples scored higher in colour, fibrosity and sour/acidity. Conventional samples scored higher in all other attributes; however, none of the differences observed had statistical significance ($P < 0.05$).

Independent $t$-tests (with Bonferroni corrections) of panel scores for individual descriptors found no significant difference ($P < 0.05$ or less) between the organic and conventional samples. The two-way repeated measures ANOVA analysed for variance between all organic and all conventional scores (201 vs. 201 mean panel scores) for sixty-seven descriptors assessed. The mean organic score was 4.918, and the mean conventional score was 4.965. The significance value of the within-subjects effects between organic and conventional data sets was 0.475, which indicates that there is no significant variance between all organic and conventional scores ($P < 0.05$).

It is clear that in this the study, panelists could not significantly distinguish between the organic and conventional fruits/vegetables, which may suggest that opinions on sensory differences in organic foods could be due to a placebo-like effect when it is known that the food is organic rather than a sensory difference that is measurable. It could also be said that differences previously observed by consumers may have been due to differences in freshness as organic foods are often locally sourced and sometimes purchased directly from producers at local food markets, as previously suggested by Trewavas (2004). The results obtained do not strengthen the opinion of some consumers that organic foods taste better and are in agreement with previous studies of carrots and potatoes by Wszelaki et al. (2005), Hajsllová et al. (2005), Gilsenan et al. (2008, 2010).

There is, however, still the question of any health benefits, contaminant levels and environmental benefits of organic foods. Research in these areas has yet to provide clear-cut answers on the benefits of organic foods, if any, but answers are needed for organic market growth and consumer knowledge and awareness.

Further publications are currently being prepared by the researchers, which will include an in-depth biochemical (secondary metabolites) and contaminant analysis, with an aim to determine whether a difference exists between organic and conventional fruits and vegetables in these areas.

**Conclusion**

The results of the research showed that the sensory panel of nine using the quantitative descriptive analysis method detected:

- no statistically significant differences ($P < 0.05$ or less) between individual descriptors of a range of organic and conventional fruits and vegetables via independent $t$-tests of panel scores.

- no significant differences ($P < 0.05$), or variance, between all organic and all conventional panel scores via a two-way repeated measures ANOVA.

In conclusion, the research found no statistically significant differences between the sensory properties of a range of organically and conventionally grown fresh fruits and vegetables available to the Irish consumer.

**Acknowledgments**

This work is supported by the Irish Research Council for Science, Engineering and Technology (IRCSET) and facilitated by Shannon Applied Biotechnology Center/Sensory Evaluation Centre.

**References**


<table>
<thead>
<tr>
<th>Independent Variable</th>
<th>Research Questions</th>
<th>Dependent Variables</th>
<th>Background Research</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Null Hypothesis</td>
<td>Accept Null Hypothesis</td>
<td>No Longer Reject Null</td>
<td>Accept Null Hypothesis</td>
</tr>
<tr>
<td>No Longer Reject Null</td>
<td>Accept Null Hypothesis</td>
<td>Accept Null Hypothesis</td>
<td>No Longer Reject Null</td>
</tr>
<tr>
<td>Procedure</td>
<td>Procedure</td>
<td>Materials</td>
<td>Sample Size</td>
</tr>
<tr>
<td>1 Significant Difference</td>
<td>1 Significant Difference</td>
<td>1 Significant Difference</td>
<td>1 Significant Difference</td>
</tr>
<tr>
<td>Accept Null Hypothesis</td>
<td>Accept Null Hypothesis</td>
<td>1 Significant Difference</td>
<td>Accept Null Hypothesis</td>
</tr>
<tr>
<td>Justification</td>
<td>Purpose</td>
<td>Background Research</td>
<td>Justification</td>
</tr>
<tr>
<td>Data Analysis Programs</td>
<td>Null Hypothesis</td>
<td>Areas Evaluated</td>
<td>Results Table</td>
</tr>
<tr>
<td>Discussion of Results</td>
<td>Discussion of Results</td>
<td>Accept Null Hypothesis</td>
<td></td>
</tr>
<tr>
<td>Areas for Additional Research</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Image of fruits and vegetables]

72
Cutouts for Scientific Article Background Research Activity

Definition of Organic Food/Production-

Definition of Conventional Food/Production-

Definition of Null Hypothesis-

Definition of Statistical Significance-

Definition of Organic Food/Production-

Definition of Conventional Food/Production-

Definition of Null Hypothesis-

Definition of Statistical Significance-
Original article

**Sensory evaluation of organic and conventional fruits and vegetables available to Irish consumers**

Rachel Tobin,* Siobhan Moane & Tracey Larkin

Department of Applied Science, Shannon Applied Biotechnology Centre, Limerick Institute of Technology, Moylish Park, Limerick, Ireland

(Received 31 January 2012; Accepted in revised form 11 July 2012)

**Summary**  Many Irish consumers believe organic foods taste better; however, scientific data to support this are scarce, inconclusive and limited in scope. Quantitative descriptive analysis was used to compare the sensory properties of nine organic and conventional fruits and vegetables. A panel of nine was trained according to ISO international standards (8586-1, 1993). Independent *t*-tests of individual descriptor data and a two-way repeated measures ANOVA of the entire data set were carried out via SPSS 19. Statistical analysis of panel scores failed to show any significant differences between the organic and conventional samples for any of the descriptors assessed (P < 0.05 and less) or between the overall organic and conventional data sets (P < 0.05). In conclusion, the study found no statistically significant differences between the sensory attributes of a range of organic and conventional fruits and vegetables available to the Irish consumer.

**Keywords**  Fruits, Ireland, organic food, sensory evaluation, vegetables.

**Introduction**

Foods are generally perceived by appearance, odour/fragrance, consistency/texture and finally flavour; however, in reality, these perceptions often occur in parallel as an overall sensory experience. Sensory evaluation attempts to isolate the sensory properties of foods and other products and can be defined as a scientific method that is used to evoke, measure and interpret responses to the sensory properties through the senses (Lawless & Heymann, 2010). Sensory evaluation assesses these properties using trained panellists or consumer groups for the purpose of rating the quality of a product, or comparing one product to another (Melgaard *et al*., 2007). In the last 20–30 years, there has been a significant development in the use of sensory evaluations in the food and beverage industry. These developments have grown from a better recognition of human perception and developments in statistical tools. Sensory evaluation can be an invaluable tool in product development and product improvement, such as the assessment of the effects of formulation changes to the sensory properties. Evaluations can also be used for comparisons to competitor products and also shelf-life establishment (Kemp *et al*., 2009).

Descriptive analysis is the detection and description of sensory properties of a product; these properties combine to define the sensory profile of the product. Products may have the same sensory profile but may differ in the intensity of the properties; these intensities can be numerically scored, which allows for a number of products to be statistically compared (Melgaard *et al*., 2007).

Organic foods can be generally defined as foods that are produced under strict regulations using an agricultural management system that promotes and enhances biodiversity, biological cycles and soil health with a minimum use of off-farm inputs. *Organic Trade Association* (2011). A 2008 survey by An Bord Bia showed that 27% of Irish consumers believe organic foods taste better, but could these consumers distinguish organic and conventional foods in a blind study? Is it possible that the perception of organic food as a more natural and safer product influences the sensory experience? (Tobin *et al*., 2011). Scientific studies on the question are limited and cover few food types. A review conducted in 2004 by Trewavas stated that research findings are inconsistent and added that freshness is an important factor often confused with organic because of local sourcing. Table 1 lists some of the most recent sensory comparisons of organic and conventional foods and their findings.

Another survey of Irish consumers by An Bord Bia showed that 21% of organic rejecters state that they do not buy organic foods because they do not know what the benefits are. This would clearly suggest that...
Background Research

Table 1 Recent studies on the sensory comparison of organic and conventional foods and their findings

<table>
<thead>
<tr>
<th>References</th>
<th>Foods tested</th>
<th>Findings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Haglund et al. (1999)</td>
<td>Carrots</td>
<td>Conventional carrots higher in carrot taste, sweetness and crunchiness. Organic carrots higher in hardness and pronounced after-taste (P &lt; 0.01 or less).</td>
</tr>
<tr>
<td>Wlezien et al. (2006)</td>
<td>Red skin potatoes</td>
<td>In a triangle test, panelists could distinguish between organic and conventional samples only when the skin was left on.</td>
</tr>
<tr>
<td>Gilsenan et al. (2008)</td>
<td>Carrots and Mushrooms</td>
<td>Descriptive analysis of carrots for appearance, aroma, texture and taste found no significant difference (P &gt; 0.05). Analysis of mushrooms for the same descriptors also showed no significant difference; however, it was indicated that organic mushrooms had higher pH and a stronger aroma (P &lt; 0.005).</td>
</tr>
<tr>
<td>Gilsenan et al. (2010)</td>
<td>Potatoes</td>
<td>No significant difference in appearance, aroma and taste was observed. However, baked conventional samples were perceived to be significantly softer, less adhesive and wetter than organic baked samples (P &lt; 0.05).</td>
</tr>
<tr>
<td>Haljani et al. (2006)</td>
<td>Potatoes</td>
<td>In a 4-year study, differences were seen within single crop years; however, pooled results showed that year-to-year, variety and geographical variations were equal or more important factors.</td>
</tr>
</tbody>
</table>

Justification

More scientific research must be carried out to inform consumers of the differences, if any, associated with organically produced foods. In a similar survey carried out by An Bord Bia, organic consumers were asked where they bought their organic products. The results showed that a large majority visit large supermarket chains and buy their organic products along with their general purchases (An Bord Bia, 2008). Many previous sensory studies on the comparison of organic and conventional foods included samples collected directly from farms only. It was also noted that, to a consumer, variations such as soil type, fertilisation and geographical factors are unknown and perhaps unimportant. Therefore, the aim of this research was to provide a consumer-relevant study of organic fruits and vegetables and their conventional counter parts to show whether Irish consumers purchasing organic fruits and vegetables receive a higher sensory quality product or whether no difference exists. The foods included in the study were also chosen based on An Bord Bia survey data on the most popular and frequently purchased organic products (An Bord Bia, 2008).

Purpose

Justification

Materials and methods

Nine fruits and vegetables were tested during the study, namely carrots (raw and cooked), onions, broccoli, vine tomatoes, cherry tomatoes, apples, potatoes, bananas and oranges. Of the fifty-four sample batches purchased for the study, 96% were sourced from large supermarkets (e.g. Tesco, Lidl) and 4% were sourced from a local organic producer to account for a minority of consumers visiting local organic markets.

Sample preparation

Six sample batches of each food (three organic and three conventional) were purchased simultaneously the day before analysis to avoid differences because of degrees of freshness. Preparation was carried out on the morning of analysis in an adjoining preparation kitchen and depended on the nature of the samples (Table 2 shows the preparation carried out for each food type). All samples were washed before preparation. Cooked samples were steamed simultaneously in a segregated household electric steamer to avoid variations because of cooking times and temperatures.

Panel training and selection

The sensory panel was recruited in January 2011. The criteria for panelists were the following: they were available to volunteer for the project, non-smokers, in good health and regular consumers of the samples included in the study. Participants who were willing to volunteer then completed a consent form and diet survey. Training in sensory analysis principals and quantitative descriptive analysis commenced with ten

Table 2 Sample preparation

<table>
<thead>
<tr>
<th>Food</th>
<th>Preparations</th>
<th>Cooking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carrots (raw)</td>
<td>Ends removed, peeled, chopped in to batons</td>
<td>N/A</td>
</tr>
<tr>
<td>Carrots (cooked)</td>
<td>Ends removed, peeled, chopped in to batons</td>
<td>Steamed for 15 min</td>
</tr>
<tr>
<td>Onion</td>
<td>Skin removed, sliced</td>
<td>Steamed for 10 min</td>
</tr>
<tr>
<td>Broccoli</td>
<td>Uniform sections prepared</td>
<td>Steamed for 15 min</td>
</tr>
<tr>
<td>Vine tomato</td>
<td>Vine removed, chopped in to segments</td>
<td>N/A</td>
</tr>
<tr>
<td>Cherry tomato</td>
<td>Vine removed, chopped in half</td>
<td>N/A</td>
</tr>
<tr>
<td>Apple</td>
<td>Stem removed, chopped into segments</td>
<td>N/A</td>
</tr>
<tr>
<td>Potato</td>
<td>Peeled, chopped into cubes</td>
<td>Steamed for 15 min</td>
</tr>
<tr>
<td>Banana</td>
<td>Peeled and broken in half</td>
<td>N/A</td>
</tr>
<tr>
<td>Orange</td>
<td>Chopped into segments</td>
<td>N/A</td>
</tr>
</tbody>
</table>
participants according to ISO international standards (8360-1, 1993). Panellists were trained over 3 months (2 h per week) on their ability to differentiate between basic taste solutions at various levels, aromas and colours. The next stage of training was to describe and discuss descriptors in fruits and vegetables in terms of appearance, aroma, texture and taste. The panel was evaluated for correct detection of basic taste solutions and consistent scoring of descriptors of fruit and vegetable reference samples. Of the ten participants, nine (two men and seven women) panellists performed sufficiently in these evaluations and proceeded to analysis.

Sensory analysis

For each evaluation, the panel would decide on a range of appropriate descriptors that should be used to assess and compare the test samples. This was done using a reference sample for each fruit/vegetable. This session acted as a panel calibration as panellists established benchmark scores for each descriptor. The panellists’ sensitivity was also tested before each evaluation using basic taste solutions. Sweet, sour, bitter, salty and savoury solutions at various levels had to be correctly identified before the panelist could sit for evaluation. This ensured all panellists were detecting changes in tastes sufficiently before scoring test samples.

For the analysis, six randomly coded prepared samples (three organic and three conventional) were placed on coded white paper plates, in no particular order, and presented to each panellist in separate white booths. The panellists used mineral water as a palate cleanser between tastings. The test room was also equipped with special white lighting and kept free from any strong smells. The panellists were instructed to assess each test sample in order of aroma intensity, visual appearance, intensity of colour, textures upon bite/chew and individual tastes observed. Each sample was scored between 1 and 9 for each of the descriptors, 1 denoting a low intensity for the descriptor and 9 denoting high intensity.

Data analysis

All panel scores were transferred to an Excel worksheet, and the means and standard deviations were calculated. The data were transferred to SPSS Statistics 19 software (SPSS Inc., Chicago, IL, USA). Independent t-tests were carried out for each fruit/vegetable for each descriptor to determine whether the samples scored significantly different for any individual attribute. The use of multiple t-tests can inflate the probability of type I experiment-wise error (false positives) however, and hence, a Bonferroni correction was applied to ensure significant differences were true differences and not because of error. The correction lowered the significance level of the test by the formula $0.5/N$ where $N$ is the total number of tests employed.

A two-way repeated measures analysis of variance (ANOVA) was carried out on the entire data set that consisted of ten fruit/vegetable groups (treating cooked and raw carrots as separate groups) with six samples of each (three organic and three conventional), sixty-seven individual descriptors with 201 vs. 201 mean panel scores for organic and conventional samples in total.

The null hypothesis for the statistical analysis was there is no significant difference between the sensory properties of the organic and conventional fruits and vegetables assessed ($P < 0.05$).

Results

The results of the quantitative descriptive analysis of the organic and conventional fruits and vegetables tested are shown in Table 3.

Discussion

The raw carrots were scored based on the following descriptors: intensity of orange colour, carrot aroma, hardness on bite, moistness on chew, crunchiness on chew, sweetness and bitterness (after-taste). Organic samples scored higher for moistness, sweetness and bitterness. Conventional samples scored higher in all other descriptors; however, differences recorded were not statistically significant ($P < 0.05$). Gishen et al. (2008) also found no significant difference ($P < 0.05$) between organic and conventional carrots. However, the study by Haglund et al. (1999) found conventional carrots scored significantly higher in sweetness and crunchiness and organic carrots scored higher in hardness and after-taste ($P < 0.01$), none of which were observed in this study.

Cooked carrots were scored based on the following descriptors: intensity of orange colour, carrot aroma, firmness on bite, moistness on chew, sweetness and bitterness (after-taste). Both samples scored equally for aroma and conventional samples scored higher in sweetness, albeit not statistically higher. The organic samples scored lower for colour, moistness, bitterness and firmness. Organic samples were calculated to be significantly higher in moistness at the $P < 0.05$ significance level; however, when the Bonferroni correction was employed, the significance level was reduced to $P = 0.0083$, which deemed the $P$ value as no longer significant, and the null hypothesis was then accepted.

Onions were compared based on the following descriptors: intensity of white/yellow colour, onion aroma, crunchiness on chew, sweetness and onion after-taste. Organic samples scored equal for sweetness and lower than conventional samples for all other

Areas Evaluated

Sample Size

Data Analysis Programs

Null Hypothesis

Accept Null Hypothesis

Accept Null Hypothesis

Accept Null Hypothesis

International Journal of Food Science and Technology © 2012 Institute of Food Science and Technology
## Results Table

### Table 2 Results of the quantitative descriptive analysis (QDA) of nine fruits and vegetables, mean panel scores and P-values

<table>
<thead>
<tr>
<th>Descriptor</th>
<th>Mean Organic</th>
<th>Mean Conventional</th>
<th>P-value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermelon</td>
<td>5.8 ± 0.33</td>
<td>6.0 ± 0.64</td>
<td>0.719</td>
</tr>
<tr>
<td>Carrot</td>
<td>3.1 ± 0.26</td>
<td>2.7 ± 0.23</td>
<td>0.129</td>
</tr>
<tr>
<td>Green pepper</td>
<td>5.8 ± 0.58</td>
<td>5.9 ± 0.22</td>
<td>0.091</td>
</tr>
<tr>
<td>Tomato</td>
<td>5.2 ± 0.46</td>
<td>5.4 ± 0.14</td>
<td>0.750</td>
</tr>
<tr>
<td>Papaya</td>
<td>0.1 ± 0.02</td>
<td>0.2 ± 0.30</td>
<td>0.661</td>
</tr>
<tr>
<td>Beetroot</td>
<td>4.4 ± 0.02</td>
<td>4.2 ± 0.45</td>
<td>0.727</td>
</tr>
<tr>
<td>Pawpaw</td>
<td>2.0 ± 0.50</td>
<td>1.7 ± 0.94</td>
<td>0.460</td>
</tr>
<tr>
<td>Orange</td>
<td>0.7 ± 0.43</td>
<td>0.0 ± 0.69</td>
<td>0.693</td>
</tr>
<tr>
<td>Cabbage</td>
<td>5.0 ± 0.36</td>
<td>5.8 ± 0.10</td>
<td>0.193</td>
</tr>
<tr>
<td>Litchi</td>
<td>2.1 ± 0.48</td>
<td>4.6 ± 0.26</td>
<td>0.516</td>
</tr>
<tr>
<td>Watermelon-ice</td>
<td>4.5 ± 0.14</td>
<td>4.8 ± 0.23</td>
<td>0.308</td>
</tr>
<tr>
<td>Sweetpotato</td>
<td>4.8 ± 0.30</td>
<td>4.6 ± 0.14</td>
<td>0.560</td>
</tr>
<tr>
<td>Turnips</td>
<td>1.8 ± 0.62</td>
<td>2.3 ± 0.30</td>
<td>0.420</td>
</tr>
<tr>
<td>Bok choy</td>
<td>3.1 ± 0.52</td>
<td>3.6 ± 0.82</td>
<td>0.586</td>
</tr>
<tr>
<td>Green onion</td>
<td>3.0 ± 0.64</td>
<td>3.3 ± 0.33</td>
<td>0.100</td>
</tr>
<tr>
<td>Beetroot-ice</td>
<td>4.4 ± 0.23</td>
<td>4.0 ± 0.31</td>
<td>0.634</td>
</tr>
<tr>
<td>Sweetpotato-ice</td>
<td>4.5 ± 0.02</td>
<td>4.0 ± 0.53</td>
<td>0.761</td>
</tr>
<tr>
<td>Bok choy-ice</td>
<td>4.0 ± 0.58</td>
<td>4.7 ± 0.14</td>
<td>0.644</td>
</tr>
<tr>
<td>Zucchini</td>
<td>6.0 ± 0.35</td>
<td>5.3 ± 0.23</td>
<td>0.173</td>
</tr>
<tr>
<td>Carrot-ice</td>
<td>5.8 ± 0.14</td>
<td>5.9 ± 0.48</td>
<td>0.346</td>
</tr>
<tr>
<td>Green onion-ice</td>
<td>4.4 ± 0.16</td>
<td>4.4 ± 0.23</td>
<td>0.554</td>
</tr>
<tr>
<td>Bok choy-ice</td>
<td>4.0 ± 0.50</td>
<td>4.3 ± 0.55</td>
<td>0.693</td>
</tr>
<tr>
<td>Turner-ice</td>
<td>4.4 ± 0.48</td>
<td>4.2 ± 0.43</td>
<td>0.763</td>
</tr>
<tr>
<td>Bok choy-ice</td>
<td>4.5 ± 0.30</td>
<td>5.5 ± 0.48</td>
<td>0.246</td>
</tr>
<tr>
<td>Tomato-ice</td>
<td>4.5 ± 0.36</td>
<td>5.0 ± 0.30</td>
<td>0.651</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>2.5 ± 0.15</td>
<td>2.0 ± 1.12</td>
<td>0.173</td>
</tr>
<tr>
<td>Carrot-ice</td>
<td>0.1 ± 0.02</td>
<td>0.2 ± 0.30</td>
<td>0.661</td>
</tr>
<tr>
<td>Green pepper-ice</td>
<td>5.0 ± 0.23</td>
<td>5.5 ± 0.38</td>
<td>0.343</td>
</tr>
<tr>
<td>Beetroot-ice</td>
<td>4.4 ± 0.16</td>
<td>4.3 ± 0.41</td>
<td>0.746</td>
</tr>
<tr>
<td>Watermelon-ice</td>
<td>4.0 ± 0.26</td>
<td>6.1 ± 1.25</td>
<td>0.002</td>
</tr>
<tr>
<td>Apple-ice</td>
<td>3.3 ± 0.43</td>
<td>2.8 ± 0.86</td>
<td>0.303</td>
</tr>
<tr>
<td>Green pepper-ice</td>
<td>4.4 ± 0.30</td>
<td>4.6 ± 0.20</td>
<td>0.073</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>4.6 ± 0.22</td>
<td>5.4 ± 1.08</td>
<td>0.349</td>
</tr>
<tr>
<td>Beetroot-ice</td>
<td>4.8 ± 0.49</td>
<td>5.9 ± 0.13</td>
<td>0.114</td>
</tr>
<tr>
<td>Watermelon-ice</td>
<td>4.3 ± 0.16</td>
<td>4.3 ± 0.56</td>
<td>0.103</td>
</tr>
<tr>
<td>Apple-ice</td>
<td>4.6 ± 0.36</td>
<td>4.7 ± 0.13</td>
<td>0.597</td>
</tr>
</tbody>
</table>

### Table 3 Continued

<table>
<thead>
<tr>
<th>Descriptor</th>
<th>Mean Organic</th>
<th>Mean Conventional</th>
<th>P-value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermelon-ice</td>
<td>4.5 ± 0.36</td>
<td>4.1 ± 0.24</td>
<td>0.690</td>
</tr>
<tr>
<td>Apple-ice</td>
<td>4.1 ± 0.20</td>
<td>4.8 ± 0.19</td>
<td>0.314</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>5.8 ± 0.32</td>
<td>5.3 ± 0.32</td>
<td>0.129</td>
</tr>
<tr>
<td>Beetroot-ice</td>
<td>4.6 ± 0.29</td>
<td>5.5 ± 0.47</td>
<td>0.127</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>3.2 ± 0.28</td>
<td>3.5 ± 0.57</td>
<td>0.447</td>
</tr>
<tr>
<td>Apple-ice</td>
<td>4.8 ± 0.36</td>
<td>4.5 ± 0.65</td>
<td>0.539</td>
</tr>
<tr>
<td>Watermelon-ice</td>
<td>4.2 ± 0.40</td>
<td>4.2 ± 0.08</td>
<td>0.116</td>
</tr>
<tr>
<td>Apple-ice</td>
<td>5.9 ± 0.50</td>
<td>5.8 ± 0.48</td>
<td>0.644</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>4.6 ± 0.32</td>
<td>4.4 ± 0.73</td>
<td>0.722</td>
</tr>
<tr>
<td>Beetroot-ice</td>
<td>6.1 ± 0.40</td>
<td>5.7 ± 0.23</td>
<td>0.173</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>5.1 ± 0.52</td>
<td>5.4 ± 0.10</td>
<td>0.584</td>
</tr>
<tr>
<td>Watermelon-ice</td>
<td>5.6 ± 0.08</td>
<td>6.0 ± 0.29</td>
<td>0.183</td>
</tr>
<tr>
<td>Orange</td>
<td>5.7 ± 0.20</td>
<td>5.4 ± 0.73</td>
<td>0.480</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>5.7 ± 0.28</td>
<td>5.6 ± 0.22</td>
<td>0.095</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>6.6 ± 0.73</td>
<td>7.0 ± 0.23</td>
<td>0.495</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>6.9 ± 0.38</td>
<td>8.0 ± 0.47</td>
<td>0.690</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>5.6 ± 0.84</td>
<td>3.5 ± 0.66</td>
<td>0.580</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>4.9 ± 1.50</td>
<td>5.2 ± 1.08</td>
<td>0.567</td>
</tr>
<tr>
<td>Zucchini-ice</td>
<td>5.0 ± 0.39</td>
<td>5.3 ± 0.39</td>
<td>0.300</td>
</tr>
</tbody>
</table>

attributes. None of the differences recorded had statistical significance at the $P < 0.05$ significance level.

Broccoli samples were scored based on the following descriptors: intensity of green colour of bouquet, compactness of bouquet, aroma (cabbage-like), aroma (savory), firmness (overall), sponginess (head), tenderness (stalk), savoury taste and cabbage taste. Conventional samples scored slightly higher for cabbage-like aroma, overall firmness, tenderness, savoury taste and cabbage taste. None of the scores were calculated to be statistically significant at the $P < 0.05$ significance level.

Vine tomatoes were scored based on the following descriptors: intensity of red colour, firmness, hardness on bite, juiciness on chew, savoury taste and sweetness. Organic samples scored just slightly higher in juiciness and savoury taste. Conventional samples scored higher for all other attributes of which colour was calculated to be significantly higher at the $P < 0.05$ significance level. The Bonferroni correction lowered the significance level to 0.0083, which then excluded the $P$ value from the significance level, and hence, the null hypothesis was no longer rejected.

Cherry tomatoes were analysed for the following descriptors: intensity of red colour, tomato aroma, hardness on bite, juiciness on chew, savoury taste and sweetness. Organic samples scored higher for colour, aroma, juiciness, savoury taste and sweetness. However, none of the differences observed were calculated to have statistical significance ($P < 0.05$).
No Longer Reject Null

Apples were scored based on their intensity of skin colour, apple aroma, hardness on bite, juiciness on chew, leathery skin, sourness, sweetness and apple flavour. Organic samples scored higher in aroma, juiciness and sourness. Conventional samples were higher in all other attributes of which sweetness was calculated to have statistical significance at the $p < 0.05$ significance level. After the Bonferroni correction, the adjusted significance level of 0.0063 excluded the $p$ value for apple sweetness and the null hypothesis was no longer rejected.

No Longer Reject Null

Potatoes were analysed for the following descriptors: intensity of white/yellow colour, potato aroma, smoothness (waxiness), flouriness (dryness/softness), potato taste, sweetness and astringency (drying after-taste). Organic samples scored higher for colour, smoothness and astringency. Conventional samples scored higher for all other descriptors of which flouriness was calculated to be statistically higher ($p < 0.05$). The Bonferroni correction lowered the level of significance to 0.0071, and hence, the null hypothesis was no longer rejected. Similarly to studies by Wszelaki et al. (2005) and Gilsenan et al. (2010), the panel did not distinguish between the organic and conventional potato samples. Hajšlová et al. (2005) did observe differences but noted other factors as more or equally important to growing method.

Accept Null Hypothesis

The panel assessed the banana samples for intensity of pale yellow colour, banana aroma, firmness on bite, astringency/dryness, sweetness and banana flavour. Organic samples scored slightly higher for colour, aroma, firmness and astringency/dryness; however, none of the differences recorded had statistical significance ($p < 0.05$).

Accept Null Hypothesis

Oranges were scored based on intensity of orange colour, orange aroma, juiciness on chew, fibrousness on chew, sourness/acidity, sweetness and orange flavour. Organic samples scored higher in colour, fibrousness and sour/acidity. Conventional samples scored higher in all other attributes; however, none of the differences observed had statistical significance ($p < 0.05$).

Discussion of Results

Independent t-tests (with Bonferroni corrections) of panel scores for individual descriptors found no significant difference ($p < 0.05$ or less) between the organic and conventional samples. The two-way repeated measures ANOVA for variance between all organic and conventional scores (201 vs. 201 mean panel scores for sixty-seven descriptors assessed) indicated that there is no significant variance between all organic and conventional scores ($p > 0.05$).

Discussion of Results

It is clear that in this study, panelists could not significantly distinguish between the organic and conventional fruits/vegetables, which may suggest that opinions on sensory differences in organic foods could be due to a placebo-like effect when it is known that the food is organic rather than a sensory difference that is measurable. It could also be said that differences previously observed by consumers may have been due to differences in freshness as organic foods are often locally sourced and sometimes purchased directly from producers at local food markets, as previously suggested by Treweavey (2004). The results obtained do not strengthen the opinion of some consumers that organic foods taste better and are in agreement with previous studies of carrots and potatoes by Wszelaki et al. (2005), Hajaslová et al. (2005), Gilsenan et al. (2008, 2010).

Conclusion

The results of the research showed that the sensory panel of nine using the quantitative descriptive analysis method detected:

- no statistically significant differences ($p < 0.05$ or less) between individual descriptors of a range of organic and conventional fruits and vegetables via independent samples of panel scores
- no significant difference ($p < 0.05$), or variance, between all organic and conventional panel scores via a two-way repeated measures ANOVA.

Acknowledgements

This work is supported by the Irish Research Council for Science, Engineering and Technology (IRCSET) and facilitated by Shannon Applied Biotechnology Center/Sensory Evaluation Centre.

References


Grading for the Agriscience Project
-as we have discussed it is important to complete each step successfully before moving on to the next therefore, if you do not receive full credit on a task you will need to make revisions
-once you complete the task I will grade it and return it to you will need to make corrections the following class period as well as completing the new assignment
-if you do not complete the work assigned in class you will need to schedule a time to come in in the morning, during lunch or after school so that you can stay on track and get your experiment started

Agriscience Notebooks
Answering Research Questions

Goals for Today

- Finish the checklist from last time if necessary.
- Complete research on background questions.
Need to Finish Tasks and Make Corrections for parts that are grade
The purpose of background research is to answer each of the background research questions.

- **Finding Resources**
  - Dictionaries or Encyclopedia
  - Product Websites
  - Trade Magazines, Guides or Handbooks
  - Scholarly Articles

  **Minimum of Four Sources**

- **Databases**
  - Use the School's Library Databases
    - Example:
      - EBSCO Host: Academic Search Premier

- **Product Websites**
  - Seed producers, breed associations, feed mills, fertilizer companies
- **Trade Magazines or Handbooks** on the Subject:
  - High Plains Journal for Crops
  - Beef Magazine for Beef etc.
- **Scholarly Articles** can be found on databases available from the Windsor High School Website or the Clearview Library Database Website
Three things you will need on the left page:
Title: Background Research: Entity Question Notes
The right hand side of the page should either be blank or have additional notes.

The notes must be hand written on the page in your own words. You will need to note your source for each fact that you find. Proper APA format - this will include parenthesis with the authors name or article title if there is no author, the year and a page number if it is from an article.

You will need to create these two pages for your entity, two additional pages for your independent variable, two pages for your dependent variable and two pages for your relationship question.

- You will need to create a reference list for all of the sources you are citing.
  - The reference list should be created as you go in a word document which you save to your personal files so you can find it in the future.
  - You should use APA style formatting for your list - if you are unsure of how to format your references using APA you can look online for help.
  - Again, you will need to provide an in text citations in your notebook using APA style for in text citations.
APA Formatting

**Journal Article:**

**Website:**

References Used:
The OWL at Purdue. (2013). Research and citation resource. Retrieved from Purdue Online Writing Lab website: http://owl.english.purdue.edu/owl/


In Text Citations

**Reference with Author:**
This is a fact for a research question (Author, Date).

**Reference with Organization or Group as Author:**
This is a fact for a research question (Group Name, Date).

**Reference with No Author:**
This is a fact for a research question (“Article Title,” Date).
Websites that Generate Citations

- Easybib.com
- Noodletools.com: click Noodle Tools Express at the bottom of the page
- citationmachine.net

APA Style Guide Online

APA Style by APA:
http://www.apastyle.org/
Tasks for Today

- Complete Checklist from Last Time
  - Observational Questions
  - Primary Research Questions
  - Not directional hypotheses
  - Entity/Variables
  - Background Research Questions

- Complete New Checklist on Answering Background Research Questions
  - Entity Research
  - Independent Variable Research
  - Dependent Variable Research
  - Relationship Research
  - References/Cladograms

You have two jobs today:
1. Complete the tasks you have left over from last time and make corrections to the tasks you completed
2. Complete the tasks for today which include your background research
Please do not check off the boxes on your check list unless you have completed them or else I will grade them as is.
Background Research Questions
Form at least one question for each area below.

Entity

Independent Variable

Dependent Variable

Relationship between Entity and Variables
Lesson 3: Data Analysis

Lesson

✓ Lesson Plan
✓ Data Analysis PowerPoint
✓ Data Analysis Job Operation Sheet: Animal Science
✓ Data Analysis Job Operation Sheet: Plant Science
✓ Data Analysis Activity Answer Keys
✓ Data Table Job Operation Sheet
✓ Data Table Activity Key

Agriscience Project

✓ Table and Graph Components Handout
**Desired Outcomes for this Lesson**

**Goal for this lesson:**
The goal for this lesson is for students to understand basic functions in Excel necessary to form tables and create charts to communicate results.

**Standards addressed in this lesson:**
ESSK.02.09.a - Create tables, charts, and figures to support written and oral communications.
ESSK.04.07.a - Create a spreadsheet.
ESSK.04.07.b - Perform calculations and analyses on data using a spreadsheet.
ESSK.04.10.a - Manage computer operations.

**Objectives: By the end of the lesson the learner will...**
- Identify and correctly apply basic functions in excel.
- Identify the key components of a graph.
- Analyze research data using Excel.
- Communicate research data results concisely using graphs and tables.

**Essential Questions:**
- Why is it important to organize research data into tables and graphs?
- Why is it important to have the key components included on a graph or table?

**Assessments to Measure Student Growth**

<table>
<thead>
<tr>
<th>Unit</th>
<th>This lesson:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completion of Agriscience Project</td>
<td>Excel Activity</td>
</tr>
<tr>
<td></td>
<td>Word Activity</td>
</tr>
</tbody>
</table>

**The Learning Plan**

<table>
<thead>
<tr>
<th>Materials:</th>
<th>Computers</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOS-Data Analysis</td>
<td></td>
</tr>
<tr>
<td>Class Experiment Graphing Workbook Excel File</td>
<td></td>
</tr>
<tr>
<td>JOS-Creating a Table</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Terms to Know:</th>
<th>Excel Function, Sum, Average, Axis, Column Chart and Pie Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources:</td>
<td>It will save time if you or an aide enters the raw data into Excel for students. The file needs to be shared with students through a school file share (if available), email or from a flash drive. Be sure to have a backup plan.</td>
</tr>
<tr>
<td>Special Instructions:</td>
<td>Hold up the score cards participants filled out during the class experiment. Ask students what they can determine about the class results from the score cards- can they tell averages, can they easily tell sample which scored higher from where they are sitting? Ask students what might help others to understand their results?</td>
</tr>
<tr>
<td>Engage-Motivation:</td>
<td>Explain to students that entering the data into Excel will allow the data to be analyzed and charts to be generated which will help them to show and explain the results to others. Show students Slides 1-3 of the PowerPoint- the important components of a table and the important components of a graph-a meaningful title, axis labels (horizontal and vertical), data labels and legend.</td>
</tr>
<tr>
<td>Time: 10 mins.</td>
<td></td>
</tr>
<tr>
<td>Elaborate-Apply in a new context: Provide students with the JOS- Data Analysis and the excel files. Be sure to go through the JOS before the lesson in order to be prepared to answer questions. Assign a different fruit or vegetable to each student in Plant Science courses. Animal Science students should all complete the JOS sheet using the Top Sirloin Sheet. Remind students to distinguish between the class worksheet (Animal Science) and the class chart worksheet (Animal Science Chart) tabs at the bottom of the screen. Emphasize the need to be precise and carefully follow the directions on the JOS. Answer questions as needed.</td>
<td></td>
</tr>
<tr>
<td>Time: 60 mins.</td>
<td></td>
</tr>
<tr>
<td>Evaluate:</td>
<td>Using Slides 4-8 of the PowerPoint, ask students to evaluate the pie graph. What components are missing? Why would it be helpful to have these components? On Slide 8 direct students to evaluate the graph generated during the activity.</td>
</tr>
<tr>
<td>Time: 10 mins.</td>
<td></td>
</tr>
<tr>
<td>Explain-Provide new information: Explain to students that data tables are essential for good research practices. Ask students why it might be important to keep records in a data table. Look for answers including the data table keeps records organized and consistent.</td>
<td></td>
</tr>
<tr>
<td>Time:</td>
<td></td>
</tr>
<tr>
<td>Time: 5 mins.</td>
<td>Elaborate-Apply in a new context: Provide students with the JOS- Creating a Data Table. Be sure to go through the JOS before the lesson in order to be prepared to answer questions. Emphasize the need to be precise and carefully follow the directions on the JOS. Answer questions as needed.</td>
</tr>
<tr>
<td>Time: 30 mins.</td>
<td></td>
</tr>
</tbody>
</table>

### Agriscience Project Tasks

| **Materials:** Composition Notebooks for Each Student  
Table and Graphing Components Checklist- Cut into Individual Check Sheets for Each Student  
Computers  
JOS for Creating a Table in Word. | **Notebook Work:** Direct students to glue the Table and Graphing Component Checklists into their notebooks on the bottom of the List Areas of Observation page. Students should fill out the areas of observation which will include measurements (growth, weight gain, etc.) and observations. Students should then sketch an outline of their data table design (what will be included).  
Students should create their data table in Word and print it out so it can be used to record data.  
**(COMPUTER REQUIRED)**  
After all of these steps are complete, the student may begin their experiment, collect data and fill in the daily journal pages.  
Once all of the data has been collected students should analyze their data by creating a graph or table to communicate results with others. **(COMPUTER REQUIRED)** |
Components of a Data Table

- Meaningful Table Title
- Row Titles
- Column Table
- Units

Data Analysis
Using the components of a graph checklist determine what is missing from this graph?
Using the components of a graph checklist determine what is missing from this graph?
Evaluate the graph created during the class activity.
Does this graph contain all of the components?
What might you change?
### Job Operation Sheet

**Class:** Agriscience - Animal Science  
**Area:** Agriscience - Data Analysis  
**Job:** Understanding Data Analysis in Excel

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedures</th>
<th>Key Points</th>
<th>Assessment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open file and Save As.</td>
<td>Open Excel file “Class Experiment Graphing Workbook.” Click Save As and name the file Last Name-Graphing Activity.</td>
<td>Be sure to Save As and insert your last name.</td>
</tr>
<tr>
<td>2.</td>
<td>Find the Worksheet for your class (Animal or Plant Science). Add a title in row 1.</td>
<td>Select your class worksheet at the bottom of the screen. Select cells A1:K1. Click Merge and Center on the Home Tab. Click on the new cell and type “Class Experiment Data.”</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td>Count the total number of participants in cell A35.</td>
<td>Select cell A35. Type =COUNT(Click and drag to select cells A5:A31. Press Enter.</td>
<td>You can click on A31 and drag up to A5. After releasing the mouse from your click and drag, do not click anywhere else or press any other keys- only press Enter.</td>
</tr>
<tr>
<td>4.</td>
<td>Count the number of “1” responses for A and B in Each Area.</td>
<td>In cell A32 type “# of Participants Responding 1.” In cell B32 type =COUNTIF(Click and drag to select cells B5:B31. Press Enter.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>Apply formula from cell B32 to cells C32:K32.</td>
<td>Select cell B32. Click on the small square in the lower right corner of the cell and drag to cell K32.</td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td>Enter data in to “Animal Science Chart” Worksheet at the bottom of the page. Select cell G2 then press Equals. Click the Animal Science Worksheet and select cell A35. Press Enter.</td>
<td>The Formula Bar should look like this:</td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td>Repeat Step 6 for Each of the Totals Cells.</td>
<td>The following cells should be linked from the Animal Science Chart (ASC) to the Animal Science (AS) sheets: ASC B6 to AS B32 ASC C6 to AS C32 ASC B7 to AS D32 ASC C7 to AS E32 ASC B8 to AS F32</td>
<td></td>
</tr>
</tbody>
</table>
8. Find the percentage of participants who selected each sample as a higher quality. Select cell E6. Type =B6/G2 Highlight G2 in the formula bar. Press F4. Press Enter. The Formula Bar should now read:  

9. Apply this formula to cells E6: F10. Select cell E6. Click on the square in the lower right corner, drag to F6. Release. Click on the square in the lower right corner of cell F6 (E6 and F6 should still be selected). Drag down to F10.  

10. Format cells E6:F10 as percentages with one decimal place. Highlight cells E6:F10. Click the Percentage icon on the Home Tab. Click the Add Decimal icon on the Home Tab.  

11. Check math. Select cell H6. Type =SUM( Select cell E6:F6. Press Enter. Select cell H6. Click on the square at the lower right corner of the cell and drag to cell H10. Cells H6:H10 should equal 100%.  

12. Insert a Chart. Click on the Insert Tab. Click on the Column Chart button. Select the first option: 2D Clustered Column. Relocate the chart one row below the data table.  


<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>15. Add Chart Title, Horizontal and Vertical Axis Labels and Data Labels.</td>
<td>In the Chart Tools Tab, select the Layout Tab. Click on the Chart Title button and select Above Chart. Press Equals and select cell A1. Click on the Axis Titles button. Select Primary Horizontal Axis- Title Below Axis. Press Equals and select cell A5. Click on the Axis Titles button. Select Primary Vertical Axis-Rotated Title. Press Equals and select cell E4. Click on Data Labels and select Outside End.</td>
</tr>
<tr>
<td>16. Resize Chart, adjust Data Labels and format Vertical Axis.</td>
<td>Select the chart. Click the Format Tab in the Chart Tools Tab. Adjust the size to Height: 5&quot; and Width: 7&quot;. Click on each Data Label and move it just enough to avoid overlapping and lines. Select the Vertical Axis. Right click and select Format Axis. Click the Number Tab and adjust the Decimal Places to zero. Click Close.</td>
</tr>
<tr>
<td>17. Print Animal Science Chart Worksheet.</td>
<td>Click cell A1 on the Animal Science Chart Worksheet. Click File, Print. Change the Orientation to Landscape. Change Scaling to Fit Sheet on One Page. Click on Page Setup and select the Header/Footer Tab. Click Custom Header… In the Left Section type your name, in the Center Section type your class section. Click on the Right Section then click the Date button.</td>
</tr>
</tbody>
</table>

**TOTAL SCORE**

/20
## Job Operation Sheet
### Class: Agriscience Plant Science
### Area: Agriscience - Data Analysis
### Job: Understanding Data Analysis in Excel

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedures</th>
<th>Key Points</th>
<th>Assessment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open file and Save As.</td>
<td>• Open Excel file “Class Experiment Graphing Workbook.” Click Save As and name the file Last Name-Graphing Activity. Be sure to Save As and insert your last name.</td>
<td>/1</td>
</tr>
<tr>
<td>2.</td>
<td>Find the Worksheet for your class (Animal or Plant Science). Add a title in row 1.</td>
<td>• Select your class worksheet you were assigned at the bottom of the screen. • Select cells A1:K1. Click Merge and Center on the Home Tab. • Click on the new cell and type “Class Experiment Data.”</td>
<td>/1</td>
</tr>
<tr>
<td>3.</td>
<td>Count the total number of participants in cell A20.</td>
<td>• Select cell A20. Type =COUNT( • Click and drag to select cells A5:A16. • Press Enter. You can click on A16 and drag up to A5. After releasing the mouse from your click and drag, do not click anywhere else or press any other keys- only press Enter.</td>
<td>/1</td>
</tr>
<tr>
<td>4.</td>
<td>Count the number of “1” responses for A and B in Each Area.</td>
<td>• In cell A17 type “# of Participants Responding 1.” • In cell B17 type =COUNTIF( • Click and drag to select cells B5:B16. • Press comma, one, then Enter.</td>
<td>/1</td>
</tr>
<tr>
<td>5.</td>
<td>Apply formula from cell B17 to cells C17:K17.</td>
<td>• Select cell B17. • Click on the small square in the lower right corner of the cell and drag to cell K17.</td>
<td>/1</td>
</tr>
<tr>
<td>6.</td>
<td>Enter data in to “Plant Science Chart” Worksheet.</td>
<td>• Click on the “Plant Science Chart” Worksheet at the bottom of the page. • Replace the [Insert Vegetable Name] in cell A1 and cell A3 with the name of the fruit or vegetable you are analyzing. • Select cell G2 then press Equals. Click the Plant Science Worksheet and select cell A20. Press Enter. The Formula Bar should look like this:</td>
<td>/1</td>
</tr>
<tr>
<td>7.</td>
<td>Repeat Step 6 for Each of the Totals Cells.</td>
<td>• The following cells should be linked (repeat Step 6 with the following) from the Plant Science Chart (PSC) to the Plant Science (PS) sheets:</td>
<td>/1</td>
</tr>
</tbody>
</table>
- PSC B6 to PS B17
- PSC C6 to PS C17
- PSC B7 to PS D17
- PSC C7 to PS E17
- PSC B8 to PS F17
- PSC C8 to PS G17
- PSC B9 to PS H17
- PSC C9 to PS I17
- PSC B10 to PS J17
- PSC C10 to PS K17

8. Find the percentage of participants who selected each sample as a higher quality.
   - Select cell E6. Type `=B6/G2`
   - Highlight `G2` in the formula bar.
   - Press F4.
   - Press Enter.

9. Apply this formula to cells E6: F10.
   - Select cell E6. Click on the square in the lower right corner, drag to F6. Release.
   - Click on the square in the lower right corner of cell F6 (E6 and F6 should still be selected).
   - Drag down to F10.

10. Format cells E6:F10 as percentages with one decimal place.
    - Click the Percentage icon on the Home Tab.
    - Click the Add Decimal icon on the Home Tab.

11. Check math.
    - Select cell H6. Type `=SUM(`
    - Select cell E6:F6.
    - Press Enter.
    - Select cell H6. Click on the square at the lower right corner of the cell and drag to cell H10.

12. Insert a Chart.
    - Click on the Insert Tab.
    - Click on the Column Chart button.
    - Select the first option: 2D Clustered Column.
    - Relocate the chart one row below the data table.

13. Select data for the chart.
    - Select the chart. In the Chart Tools Tab, click on the Design Tab. Click the Select Data button.
    - Click Add under the Legend Entries.
    - In the box for Series Name press Equals and click E5.
    - Click Okay.
    - Click Add under the Legend Entries.
    - In the box for Series Name press Equals and click F5.
    - Delete the text in the Series Values box.
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.</td>
<td><strong>Label the categories.</strong>&lt;br&gt;• Click <strong>Edit</strong> under the Horizontal (Category) Axis Label.&lt;br&gt;• In the Axis Label Range box press <strong>Equals</strong> and select A6:A10.&lt;br&gt;• Click <strong>Okay</strong>.&lt;br&gt;• Click <strong>Okay</strong> to exit the Select Data Source Window.</td>
</tr>
<tr>
<td>15.</td>
<td><strong>Add Chart Title, Horizontal and Vertical Axis Labels and Data Labels.</strong>&lt;br&gt;• In the Chart Tools Tab, select the Layout Tab.&lt;br&gt;• Click on the Chart Title button and select Above Chart.&lt;br&gt;• Press <strong>Equals</strong> and select cell A1.&lt;br&gt;• Click on the Axis Titles button.&lt;br&gt;• Select Primary Horizontal Axis- Title Below Axis.&lt;br&gt;• Press <strong>Equals</strong> and select cell A5.&lt;br&gt;• Click on the Axis Titles button.&lt;br&gt;• Select Primary Vertical Axis- Rotated Title.&lt;br&gt;• Press <strong>Equals</strong> and select cell E4.&lt;br&gt;• Click on Data Labels and select Outside End.</td>
</tr>
<tr>
<td>16.</td>
<td><strong>Resize Chart, adjust Data Labels and format Vertical Axis.</strong>&lt;br&gt;• Select the chart. Click the Format Tab in the Chart Tools Tab.&lt;br&gt;• Adjust the size to Height: 5” and Width: 7”.&lt;br&gt;• Click on each Data Label and move it just enough to avoid overlapping and lines.&lt;br&gt;• Select the Vertical Axis. Right click and select Format Axis.&lt;br&gt;• Click the Number Tab and adjust the Decimal Places to zero.&lt;br&gt;• Click Close. Make sure there is a box around the axis values.</td>
</tr>
<tr>
<td>17.</td>
<td><strong>Print Animal Science Chart Worksheet.</strong>&lt;br&gt;• Click cell A1 on the Animal Science Chart Worksheet.&lt;br&gt;• Click File, Print.&lt;br&gt;• Change the Orientation to Landscape.&lt;br&gt;• Change Scaling to Fit Sheet on One Page.&lt;br&gt;• Click on Page Setup and select the Header/Footer Tab.&lt;br&gt;• Click Custom Header…&lt;br&gt;• In the Left Section type your name, in the Center Section type your class section.&lt;br&gt;• Click on the Right Section then click the Date button.&lt;br&gt;• Press Print. Make sure the print area is set to Print Active Sheets.</td>
</tr>
<tr>
<td>18. Submit an electronic copy of your file.</td>
<td>• Place your file in the correct folder for grading.</td>
</tr>
<tr>
<td>TOTAL SCORE</td>
<td></td>
</tr>
</tbody>
</table>
### Sensory Analysis of Top Sirloin Quality - Organic vs. Conventional

**Total Number of Participants:** 27

<table>
<thead>
<tr>
<th>Area Evaluated</th>
<th>Sample A</th>
<th>Sample B</th>
<th>Percent of Votes Higher Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Appearance of Uncooked</strong></td>
<td>6</td>
<td>21</td>
<td>22.2%</td>
</tr>
<tr>
<td><strong>Appearance of Cooked</strong></td>
<td>16</td>
<td>11</td>
<td>59.3%</td>
</tr>
<tr>
<td><strong>Smell</strong></td>
<td>16</td>
<td>11</td>
<td>59.3%</td>
</tr>
<tr>
<td><strong>Taste</strong></td>
<td>16</td>
<td>11</td>
<td>59.3%</td>
</tr>
<tr>
<td><strong>Tenderness</strong></td>
<td>18</td>
<td>9</td>
<td>66.7%</td>
</tr>
</tbody>
</table>

**Organic:**
- Appearance of Uncooked: 77.8%
- Appearance of Cooked: 40.7%
- Smell: 40.7%
- Taste: 40.7%
- Tenderness: 33.3%

**Conventional:**
- Appearance of Uncooked: 22.2%
- Appearance of Cooked: 40.7%
- Smell: 40.7%
- Taste: 40.7%
- Tenderness: 33.3%

**Graph:**
- Bar chart showing the percentage of votes for each area evaluated with Organic and Conventional categories.

---

**Class Experiment Data**

**Top Sirloin**

<table>
<thead>
<tr>
<th>Participant</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>13</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>19</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>20</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>21</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>22</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>23</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>24</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>25</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>26</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>27</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

**# of Participants Responding:** 1

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>21</td>
<td>16</td>
<td>11</td>
<td>16</td>
<td>11</td>
<td>16</td>
<td>11</td>
<td>18</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Class Experiment Data

#### Tangerine

<table>
<thead>
<tr>
<th>Participant</th>
<th>Appearance of Product</th>
<th>Appearance of Cut Product</th>
<th>Smell</th>
<th>Texture</th>
<th>Taste</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A</td>
<td>B</td>
<td>A</td>
<td>B</td>
<td>A</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>12</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th># of Participants Responding</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Number of Participants</td>
<td>6</td>
<td>6</td>
<td>5</td>
<td>7</td>
<td>5</td>
<td>7</td>
<td>4</td>
<td>8</td>
<td>4</td>
<td>8</td>
</tr>
</tbody>
</table>
### Sensory Analysis of Apple Quality: Organic vs. Conventional

<table>
<thead>
<tr>
<th>Area Evaluated</th>
<th>Number of Votes Higher Quality</th>
<th>Percent of Votes Higher Quality</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sample A</td>
<td>Sample B</td>
<td>Organic</td>
</tr>
<tr>
<td>Appearance of Product</td>
<td>6</td>
<td>6</td>
<td>50.0%</td>
</tr>
<tr>
<td>Appearance of Cut Product</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Smell</td>
<td>6</td>
<td>6</td>
<td>50.0%</td>
</tr>
<tr>
<td>Texture</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Taste</td>
<td>6</td>
<td>6</td>
<td>50.0%</td>
</tr>
</tbody>
</table>

**Total Number of Participants:** 12
## Sensory Analysis of Blueberries Quality - Organic vs. Conventional

### Blueberries

<table>
<thead>
<tr>
<th>Area Evaluated</th>
<th>Number of Votes Higher Quality</th>
<th>Percent of Votes Higher Quality</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance of Product</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Appearance of Cut Product</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Smell</td>
<td>0</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Texture</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Taste</td>
<td>6</td>
<td>6</td>
<td>50.0%</td>
</tr>
</tbody>
</table>

### Sensory Analysis of Blueberries Quality - Organic vs. Conventional

#### Area Evaluated

- **Appearance of Product**
  - Organic: 66.7%
  - Conventional: 66.7%

- **Appearance of Cut Product**
  - Organic: 33.3%
  - Conventional: 0%

- **Smell**
  - Organic: 0.0%
  - Conventional: 0.0%

- **Texture**
  - Organic: 50.0%
  - Conventional: 50.0%

- **Taste**
  - Organic: 66.7%
  - Conventional: 66.7%

### Total Number of Participants

- **12**
## Sensory Analysis of Bell Pepper Quality- Organic vs. Conventional

<table>
<thead>
<tr>
<th>Area Evaluated</th>
<th>Total Number of Participants</th>
<th>Number of Votes Higher Quality</th>
<th>Percent of Votes Higher Quality</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Sample A</td>
<td>Sample B</td>
</tr>
<tr>
<td>Appearance of Product</td>
<td></td>
<td>0</td>
<td>12</td>
</tr>
<tr>
<td>Appearance of Cut Product</td>
<td></td>
<td>4</td>
<td>8</td>
</tr>
<tr>
<td>Smell</td>
<td></td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Texture</td>
<td></td>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>Taste</td>
<td></td>
<td>4</td>
<td>8</td>
</tr>
</tbody>
</table>

### Data Representation

#### Appearance
- **Organic** vs. **Conventional**

#### Appearance of Cut
- **Organic** vs. **Conventional**

#### Smell
- **Organic** vs. **Conventional**

#### Texture
- **Organic** vs. **Conventional**

#### Taste
- **Organic** vs. **Conventional**

The diagram visually represents the sensory analysis data, showing the percent of votes higher quality for each category.
Sensory Analysis of Celery Quality: Organic vs. Conventional

<table>
<thead>
<tr>
<th>Area Evaluated</th>
<th>Number of Votes Higher Quality</th>
<th>Percent of Votes Higher Quality</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance of Product</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Appearance of Cut Product</td>
<td>0</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Smell</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Texture</td>
<td>5</td>
<td>7</td>
<td>41.7%</td>
</tr>
<tr>
<td>Taste</td>
<td>6</td>
<td>6</td>
<td>50.0%</td>
</tr>
</tbody>
</table>

Sensory Analysis of Celery Quality- Organic vs. Conventional

- Appearance of Product: Organic 66.7%, Conventional 0.0%
- Appearance of Cut Product: Organic 66.7%, Conventional 0.0%
- Smell: Organic 33.3%, Conventional 66.7%
- Texture: Organic 58.3%, Conventional 41.7%
- Taste: Organic 50.0%, Conventional 50.0%
## Sensory Analysis of Carrots Quality: Organic vs. Conventional

### Carrots

**Total Number of Participants:** 12

<table>
<thead>
<tr>
<th>Area Evaluated</th>
<th>Number of Votes Higher Quality</th>
<th>Percent of Votes Higher Quality</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Organic</td>
<td>Conventional</td>
<td></td>
</tr>
<tr>
<td>Appearance of Product</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Appearance of Cut Product</td>
<td>0</td>
<td>0</td>
<td>0.0%</td>
</tr>
<tr>
<td>Smell</td>
<td>8</td>
<td>4</td>
<td>66.7%</td>
</tr>
<tr>
<td>Texture</td>
<td>4</td>
<td>8</td>
<td>33.3%</td>
</tr>
<tr>
<td>Taste</td>
<td>5</td>
<td>7</td>
<td>41.7%</td>
</tr>
</tbody>
</table>

### Sensory Analysis of Carrots Quality- Organic vs. Conventional

- **Appearance of Product:** Organic - 4, Conventional - 8, Percent - 33.3%
- **Appearance of Cut Product:** Organic - 0, Conventional - 0, Percent - 0%
- **Smell:** Organic - 8, Conventional - 4, Percent - 66.7%
- **Texture:** Organic - 4, Conventional - 8, Percent - 33.3%
- **Taste:** Organic - 5, Conventional - 7, Percent - 41.7%

The bar chart illustrates the sensory analysis of carrots quality between organic and conventional categories.
<table>
<thead>
<tr>
<th>Step</th>
<th>Procedures</th>
<th>Key Points</th>
<th>Assessment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open New Blank Document file and Save.</td>
<td>Open Excel file &quot;Class Experiment Graphing Workbook.&quot; Click Save As and name the file Last Name-Creating a Table. Be sure to Save As and insert your last name.</td>
<td>/1</td>
</tr>
<tr>
<td>2.</td>
<td>Change document to a landscape orientation.</td>
<td>Click on Page Layout Tab. Click on the Orientation Button and select Landscape from the drop down menu.</td>
<td>/1</td>
</tr>
<tr>
<td>3.</td>
<td>Insert Table.</td>
<td>Click the Insert Tab. Click on the Table drop down button. Click on the Insert Table button.</td>
<td>/1</td>
</tr>
<tr>
<td>4.</td>
<td>Choose number of rows and columns.</td>
<td>Change the number of columns to 5 and number of rows to 9. Press Okay. Remember when creating table an additional row is necessary for a title and column labels. An additional column is necessary for row labels.</td>
<td>/1</td>
</tr>
<tr>
<td>5.</td>
<td>Enter column titles.</td>
<td>Select the 1st column of the 1&lt;sup&gt;st&lt;/sup&gt; row. Type Date. Press tab type “Growth in Direct Sunlight (cm)” Press tab type “Growth in Partial Sunlight (cm)” Press tab type “Growth in Full Shade (cm)” Press tab type “Observations.” Pressing tab should take the cursor to the next column in the second row. Always include an observation column when collecting data if appropriate.</td>
<td>/1</td>
</tr>
<tr>
<td>6.</td>
<td>Enter row titles.</td>
<td>Type dates in each row. Click on the 1&lt;sup&gt;st&lt;/sup&gt; column in the 2&lt;sup&gt;nd&lt;/sup&gt; row and type “2/4.” Press the arrow down button and type “2/11.” Fill in each of the remaining cells in the first row with the dates “2/18,” “2/25,” “3/4,” “3/11,” “3/18,” and “3/25.” Pressing the arrow down button will move the cursor down one row in the first column. Eight dates should be entered and all rows in the first column should be filled.</td>
<td>/1</td>
</tr>
<tr>
<td>7.</td>
<td>Edit column width for Date column.</td>
<td>Select the all rows in the 2&lt;sup&gt;nd&lt;/sup&gt;, 3&lt;sup&gt;rd&lt;/sup&gt; and 4&lt;sup&gt;th&lt;/sup&gt; column. With the cells still highlighted, click on the Table Tools Tab click on the Layout Tab press the Decrease Width arrow until the width is 0.7”.</td>
<td>/1</td>
</tr>
<tr>
<td>8.</td>
<td>Edit column width for specific columns.</td>
<td>Select the all rows in the 2&lt;sup&gt;nd&lt;/sup&gt;, 3&lt;sup&gt;rd&lt;/sup&gt; and 4&lt;sup&gt;th&lt;/sup&gt; column. With the cells still highlighted, click on the Table Tools Tab click on the Layout Tab and type 1.3” in the width box. Highlight the Observations column and increase the width to 4.5”.</td>
<td>/1</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.</td>
<td>Add a title row. Select the entire 1st row of the table. Click the Table Tools Tab. Click Insert Above button. Click Merge on the Layout Tab. With the row still highlighted click the Align Top Center Tab. Click on the new cell and type “Effect of Light on Growth of Corn Plants.” The Table Tools Tab will only appear when you have selected the graph.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.</td>
<td>Format title font size and style. Select the 1st row and under the Home Tab and press the Bold button. Then press the Grow Font button once. Font should be 12pt now in title row only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11.</td>
<td>Format row height. Select the all of row 3-8. With the cells still highlighted, click on the Table Tools Tab click on the Layout Tab and type 1.3” in the width box.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12.</td>
<td>Insert a Header Click on the Insert Tab. Press the Header drop down menu. Click on Edit Header. Type your name. Press tab and type your class name. Press tab and type the date.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13.</td>
<td>Print Creating a Table Word Document. Click File, Print. Check the page Orientation is set to Landscape. Click the Print Button. Be sure only one page is being printed. If there is more than one page listed, there is a formatting problem.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOTAL SCORE</td>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>Growth in Direct Sunlight (cm)</td>
<td>Growth in Partial Sunlight (cm)</td>
<td>Growth in Full Shade (cm)</td>
</tr>
<tr>
<td>-------</td>
<td>-------------------------------</td>
<td>---------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>2/4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/25</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3/25</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Components of a Graph:
- Meaningful Graph Title
- Category Labels on the Horizontal Axis
- Legend
- Vertical Axis Label
- Horizontal Axis Label
- Data Labels

Components of a Table:
- Meaningful Table Title
- Row Titles
- Column Titles
- Units
• Lesson 4: Discussion of Results

Lesson
✓ Lesson Plan
✓ Class Experiment Discussion of Results Activity
✓ Class Experiment Discussion of Results Activity Key
**Goal for this lesson:**
The goal of this lesson is to teach students how to discuss their results and effectively communicate with others through writing.

**Standards addressed in this lesson:**
- ESSK.02.05.a - Compose multi-paragraph documents clearly, succinctly, and accurately.
- ESSK.02.09.b - Interpret tables, charts, and figures used to support written and oral communication.

**Objectives:**
- By the end of the lesson the learner will...
  - Identify information that should be included in a discussion.
  - Evaluate Discussion of Results written by themselves and by others.

**Essential Questions:**
- What should be included in a quality discussion of results?
- What is the purpose of a discussion of results?

**Assessments to Measure Student Growth**

<table>
<thead>
<tr>
<th>Unit: Agriscience Project</th>
<th>This lesson: Class Experiment Discussion of Results Activity</th>
</tr>
</thead>
</table>

**The Learning Plan**

| Materials: | Class Experiment Discussion of Results Activity  
Class Experiment Discussion of Results Activity  
Copy of Results Table and Graph from the Data Analysis Lesson |
| Resources: | Class Experiment Discussion of Results Activity Key must be created based on the results of the class experiment. |

**Engage-Motivation:**
Place graphs and tables from the class experiment or another experiment around the room or on the white board. Give students five minutes to look at the data and determine the key points. Ask students if it was easy for them to identify the important pieces of information they need to take away, would it be easy for someone who did not participate in collecting the data? What might help someone understand the important points?

**Time:** 5 mins.

**Explain-Provide new information:**
Tell students the purpose of a discussion of results is two-fold. The discussion highlights the key points or interesting facts present in the graphs or tables and prepares the reader for the conclusions that will be drawn in the final section of the report by providing the supporting data.

**Time:** 10 mins

**Elaborate-Apply in a new context:**
Provide students with the Class Experiment Discussion of Results Activity worksheet and a copy of the results from the data analysis of the class experiment (graph and table). Instruct students to fill in the blanks of the discussion students may write additional information at the bottom of the page or on the back and then edit the discussion of results by crossing out any pieces of information they do not feel is important in the fill in the blank section (after filling in all blanks) and making an corrections necessary to improve flow.

**Time:** 20 mins

**Agriscience Project Tasks**

| Materials: | Composition Notebooks for Each Student  
Results from Data Analysis of Student Projects  
Computer |
| Notebook Work: | Direct students complete a discussion of results summarizing and highlighting the key points of their results. Students should write notes (bullet points) in their notebook.  
Students should then use a computer to type their discussion using full sentences. (COMPUTER REQUIRED) |
Class Experiment: Organic vs. Conventional

Discussion of Results

A total of _________ individuals participated in this study. Organic and conventional samples of ____________________ were evaluated by the participants. Participants evaluated the samples based on five areas: ________________________, ________________________, ________________________, ________________________, and ________________________. Participants showed a preference for the ________________________ product in the area of ________________________ with ________ % choosing the sample over the ________________________ sample. In the area of ________________________ individuals preferred the ________________________ sample (______ %). __________ percent of participants ranked the ________________________ sample as superior in ________________________. The participants preferred the ________________________ of the ________________________ over the ________________________ sample. __________ percent of participants responded that the ________________________ product had a more desirable ________________________. The majority of participants preferred _________ out of five qualities of the ________________________ sample while they only favored _________ of five qualities of the ________________________ sample.
Class Experiment: Organic vs. Conventional

Discussion of Results

A total of 27 individuals participated in this study. Organic and conventional samples of Top Sirloin were evaluated by the participants. Participants evaluated the samples based on five areas: appearance of uncooked, appearance of cooked, smell, taste, and tenderness. Participants showed a preference for the organic product in the area of appearance of uncooked with 77.8% choosing the sample over the conventional sample. In the area of cooked appearance individuals preferred the conventional sample (59.3%). Fifty-nine percent of participants ranked the conventional sample as superior in smell. The participants preferred the taste of the conventional sample over the organic sample. Sixty-seven percent of participants responded that the conventional product had a more desirable tenderness. The majority of participants preferred four out of five qualities of the conventional sample while they only favored one of five qualities of the organic sample.
Lesson 5: Conclusions

Lesson

✓ Lesson Plan
✓ Jigsaw Activity: Conclusion Writing
Desired Outcomes for this Lesson

Goal for this lesson:
The goal for this lesson is for students to build the skills necessary to write a quality conclusion that provides the students
audience with a clear understanding of the outcome of the research.

Standards addressed in this lesson:
ESSK.02.05.a- Compose multi-paragraph documents clearly, succinctly, and accurately.
ESSK.02.05.c- Use correct grammar, spelling, punctuation, and capitalization when preparing written documents.

Objectives: By the end of the lesson the learner will:
- Draw general conclusions from experimental data.
- Communicate conclusion with others in a concise manner.

Essential Questions:
What are the four areas of a conclusion?
What is the purpose of a conclusion?

Assessments to Measure Student Growth

Unit: Agriscience Project
This lesson: Writing a Conclusion Jigsaw Activity

The Learning Plan

| Materials: | Jigsaw Activity Worksheets (1 copy of the four pages needed per group) |
| 3 Packages of Cookies (Oreo, Double Stuffed Oreo, and Golden Oreos) |
| Terms to Know: |
| Resources: |
| Special Instructions: |
| Engage-Motivation: |
| Time: 10 mins. |
| Place three packages of cookies in front of the class. Remove ½ of the cookies from the Oreo package, remove ⅓ of the cookies from the Double Stuffed Oreo package and leave all cookies in the Golden Oreo package. Instruct students to write a paragraph drawing a conclusion based on what they see. Perhaps they determine that traditional Oreos are more popular or the Golden Oreos were new package or not allowed to be eaten. Discuss as a class the different conclusions that were reached. Ask why it is important for a researcher to write a conclusion rather than letting the reader figure it out on their own? Does the reader always have all the information they need to draw the correct conclusion? Did the students have enough information to draw the correct conclusion about the cookies? |
| Explain-Provide new information: |
| Time: 10 mins |
| Tell students that there are typically four important areas of a conclusion. This is the section where the reader looks for what was outcome (general conclusions), how can I use this information (application), what could have affected the results (limitations) and where do we go from here (areas for additional research). The areas of the conclusion including general conclusions, applications, limitations and areas for additional research. |
| Elaborate-Apply in a new context: |
| Time: 50 mins. |
| Divide students into groups of four assign each of the four students a letter A-D. Explain to students that this is the group they will work with to write a conclusion for the class experiment. Tell the students that each group member will be sent to a different group to discuss a portion of the conclusion. The students will then return and explain what they discussed to the rest of the group. Ask students to move to their letter group. Give students 15-20 minutes to discussion as a group. When time is up instruct students to return to their original group. Allow 30 minutes for the groups to discuss each portion of the conclusion and to write their conclusion (each student should write their own). Remind students that the letter groups may have missed some important ideas and therefore they should discuss any additions that may need to be made. When time is up ask each group to share the key points of their conclusion with the class and highlight any additional thoughts they included. |

Agriscience Project Tasks

| Materials: | Composition Notebooks for Each Student |
| Computers |
| Notebook Work: | Direct students to evaluate their own research project and draw their conclusions using the results from their data analysis and discussion of results. Students should write notes (bullet points) in their notebook for each of the areas of the conclusion including general conclusions, applications, limitations and areas for additional research. Students should then use a computer to type their conclusion using full sentences. **(COMPUTER REQUIRED)** |
Conclusion Writing Jigsaw Activity

Directions: Answer each question as a group. Take notes to share with original group.

**Group A: General Conclusion**

-What the hypothesis accepted or rejected? Restate the hypothesis in this statement.

-Support acceptance or rejection of hypothesis with specific results.

Conclusion (Do not write here until you return to your original group)
Conclusion Writing Jigsaw Activity

Directions: Answer each question as a group. Take notes to share with original group.

**Group B: Limitations**

- List at least three possible limitations to the research.

- What was the cause of these weaknesses?

- How might they have been avoided?

Conclusion (Do not write here until you return to your original group)
Conclusion Writing Jigsaw Activity

Directions: Answer each question as a group. Take notes to share with original group.

Group C: Application

-What industries in agriculture will be able to use information discovered during the research?

-How will the information help these industries?

-How are individuals impacted? Consumers? Producers?

Conclusion (Do not write here until you return to your original group)
Conclusion Writing Jigsaw Activity

Directions: Answer each question as a group. Take notes to share with original group.

Group D: Areas for Additional Research

- What is the next step after this research? Be specific.

- List additional questions that may have been raised based on the results seen?

Conclusion (Do not write here until you return to your original group)
• Lesson 6: Creating a Poster

Lesson
✓ Lesson Plan
✓ What Not to Do in a Presentation PowerPoint
✓ What Not to Do in a Presentation Activity

Agriscience Project
✓ Poster Layout
✓ Agriscience Presentation Grading Rubric
**Class:** Agriscience  
**Area:** Agriscience Fair Projects  
**Job:** Understanding the Effective Presentation  
**Lesson:** Creating Posters and Preparing for Presentations

**Time:** 1 hr 40 minutes plus time for individual projects

---

### Desired Outcomes for this Lesson

**Goal for this lesson:**
The goal of this is for students understand how to put together a professional poster displaying their results and good practices for giving oral presentations.

**Standards addressed in this lesson:**
ESSK.02.03.c - Reference the sources of information.
ESSK.02.05.c - Use correct grammar, spelling, punctuation, and capitalization when preparing written documents.
ESSK.02.06.a - Prepare oral presentations to provide information for specific purposes and audiences.
ESSK.02.06.c - Prepare support materials that will enhance an oral presentation.

**Objectives:** *By the end of the lesson the learner will...*
- Identify characteristics of a quality presentation.
- Create a poster that meets specified standards.
- Evaluate their presentations and posters.

**Essential Questions:**
- What are the characteristics of a quality presentation?
- What are the characteristics of a professional poster?

### Assessments to Measure Student Growth

**Unit:** Agriscience Fair Project  
**This lesson:** Project Poster Display Presentation

---

### The Learning Plan

**Materials:**
- What Not to Do Presentation Demonstration
  - What Not to Do Presentation Demonstration PowerPoint
  - What Not to Do Presentation Demonstration Script
  - What Not to Do Demonstration Activity
- Poster Layout
- Poster Board
- Color Paper (cardstock can be used to frame each section)
- Glue
- Computer/Printer to Print Poster Components
- Agriscience Fair Presentation Rubric

**Terms to Know:**

**Resources:**
If student projects are being used for a specific competition check the rules for appropriate formatting. For example: FFA Agriscience Fair Project Guidelines are available in a PDF on the FFA website.

**Special Instructions:**
If student projects are being used for a specific competition check the rules for appropriate formatting. For Example: FFA Agriscience Fair Project Guidelines are available in a PDF on the FFA website.

**Engage-Motivation:**
Act out the What Not to Do Presentation Demonstration. Ask student how they would feel if they gave a presentation like this? Time: 20 mins.

**Explore-Discovery of information:**
Ask students to take out a piece of paper and fold it in half to form two long columns. Title the left column as “Problems with Presentation” and the right column “Characteristics of a Good Presentation.”
If students need prompting, ask what was wrong with this presentation. Was the PowerPoint easy to read? Was it easy to listen to? What distracted from the presentation? Time: 10 mins

**Explain-Provide new information:**
Explain to student the characteristics of a professional poster.
- Consistency: including font and layout.
- Cleanliness: straight cut edges of papers and no handwriting on poster (only typed).
Time: 10 mins

**Elaborate-Apply in a new context:**
Give each student a poster board. Remind them to follow the poster layout- they would be expect to follow guidelines and meet specifications if this was a project for their job. Specify how you would like students to cutout the components of the poster and the method in which they should frame the components with colored paper (if this method is chosen). Given guidelines if students are allowed to use any other decorations.
Time: 60 mins

**Evaluate:**
Have students present their project to the class or a panel of judges. Judges or students should ask each
student 2-3 questions after their presentation. The student should then fill out the Agriscience Fair Presentation Rubric evaluating their own presentation. The judges should also fill out the rubric so the student can compare their evaluation to the judges. Comments can be written on the back of the rubric.
Do not tell students that this is an example of a bad presentation beforehand.
Read script - read directly from the script and stare at it without looking up.
Script: My presentation is on how to give a presentation.

Components of an Oral Presentation
- Introduction
- Hypothesis
- Materials and Methods
- Results
- Analysis and Conclusions
- Closure

Read script - read directly from the script but stare at the slide on the screen without looking at the audience.
Script: There are six areas of an oral presentation. The Introduction, Hypothesis, Materials and Methods, Results, Analysis and Conclusion, Closure. I don’t know what those are because this is a presentation on how to give a presentation so I didn’t need a hypothesis or anything like that.

(Harland, 2011)
introduction

- You can use humor in the introduction if you want and try to involve your audience you want to “hook” the audience and make sure to use your poster. Don’t put in too much text that distracts your audience because they are trying to read it all. Then when you finish the introduction you should tell them the hypothesis but not word for word because it doesn’t have to be “impersonal” like your introduction in that paper you wrote.
Script:
When you have done everything else in your presentation you should finish by doing these things. I assume you know that IV stands for independent variable and dependent variable since you did your project right?

Script:
You should probably like prepare for your presentation, like um maybe practice it or something the day before, I don’t know maybe. Um… well that is it I guess. If you don’t understand just google it, it’s not hard. And I just put that picture up there because I thought it was cute.

Do you have any questions? **Respond to all questions with I don’t know.**
Meaningful Title
Subtitle (if appropriate)

Hypothesis
If Then Hypothesis

Introduction
Purpose
Entity Research
Independent Variable Research
Dependent Variable Research
Relationship Research

Materials

Procedures

Graph or Data Table

Graph or Data Table

Discussion of Results

Conclusion

Reference List

Acknowledgements

Picture

Picture

Picture

Picture
### Agriscience Presentation Rubric

**Presenter:** _______________________________

**Presentation Topic:** _______________________________  **Total Score:** _________

<table>
<thead>
<tr>
<th>Category</th>
<th>1 Point</th>
<th>0 Points</th>
<th>Points Earned</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preparation</strong></td>
<td>Student prepared any necessary material ahead of time and prepared a thoughtful speech.</td>
<td>Student was unprepared and did not prepare a speech in advance.</td>
<td></td>
</tr>
<tr>
<td><strong>Knowledge</strong></td>
<td>Student conducted adequate research on the subject and demonstrates a clear understanding of the topic.</td>
<td>Student did not research the subject and did not show understanding of the subject.</td>
<td></td>
</tr>
<tr>
<td><strong>Clarity/Voice</strong></td>
<td>Student communicates the information clearly and in a professional manner.</td>
<td>Student was unclear and/or unprofessional.</td>
<td></td>
</tr>
<tr>
<td><strong>Response to Questions</strong></td>
<td>Student was able to answer questions thoughtfully and in a professional manner.</td>
<td>Student did not answer questions appropriately.</td>
<td></td>
</tr>
<tr>
<td><strong>Overall Presentation</strong></td>
<td>The presentation was appropriate, on topic, on time and professional.</td>
<td>The presentation was inappropriate, late or off topic.</td>
<td></td>
</tr>
</tbody>
</table>

### Agriscience Presentation Rubric

**Presenter:** _______________________________

**Presentation Topic:** _______________________________  **Total Score:** _________

<table>
<thead>
<tr>
<th>Category</th>
<th>1 Point</th>
<th>0 Points</th>
<th>Points Earned</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preparation</strong></td>
<td>Student prepared any necessary material ahead of time and prepared a thoughtful speech.</td>
<td>Student was unprepared and did not prepare a speech in advance.</td>
<td></td>
</tr>
<tr>
<td><strong>Knowledge</strong></td>
<td>Student conducted adequate research on the subject and demonstrates a clear understanding of the topic.</td>
<td>Student did not research the subject and did not show understanding of the subject.</td>
<td></td>
</tr>
<tr>
<td><strong>Clarity/Voice</strong></td>
<td>Student communicates the information clearly and in a professional manner.</td>
<td>Student was unclear and/or unprofessional.</td>
<td></td>
</tr>
<tr>
<td><strong>Response to Questions</strong></td>
<td>Student was able to answer questions thoughtfully and in a professional manner.</td>
<td>Student did not answer questions appropriately.</td>
<td></td>
</tr>
<tr>
<td><strong>Overall Presentation</strong></td>
<td>The presentation was appropriate, on topic, on time and professional.</td>
<td>The presentation was inappropriate, late or off topic.</td>
<td></td>
</tr>
</tbody>
</table>

### Agriscience Presentation Rubric

**Presenter:** _______________________________

**Presentation Topic:** _______________________________  **Total Score:** _________

<table>
<thead>
<tr>
<th>Category</th>
<th>1 Point</th>
<th>0 Points</th>
<th>Points Earned</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preparation</strong></td>
<td>Student prepared any necessary material ahead of time and prepared a thoughtful speech.</td>
<td>Student was unprepared and did not prepare a speech in advance.</td>
<td></td>
</tr>
<tr>
<td><strong>Knowledge</strong></td>
<td>Student conducted adequate research on the subject and demonstrates a clear understanding of the topic.</td>
<td>Student did not research the subject and did not show understanding of the subject.</td>
<td></td>
</tr>
<tr>
<td><strong>Clarity/Voice</strong></td>
<td>Student communicates the information clearly and in a professional manner.</td>
<td>Student was unclear and/or unprofessional.</td>
<td></td>
</tr>
<tr>
<td><strong>Response to Questions</strong></td>
<td>Student was able to answer questions thoughtfully and in a professional manner.</td>
<td>Student did not answer questions appropriately.</td>
<td></td>
</tr>
<tr>
<td><strong>Overall Presentation</strong></td>
<td>The presentation was appropriate, on topic, on time and professional.</td>
<td>The presentation was inappropriate, late or off topic.</td>
<td></td>
</tr>
</tbody>
</table>